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Your Field Guide to Wireless JargonPlus:

HOW TO: 
■ Boost Your MacBook Pro’s Storage
■ Supercharge Safari
■ Extend Firefox’s Capabilities
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  Tech support 

  Productivity apps 

  Voice & video calls

  Creativity software

  Music & video content

How to outfi t your Mac 
without spending a dime!

REVIEWED:
■ iPod shuffl e
■ LaCie Little Big Disk
■ Pentax K100D SLR Camera
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70 Ask Us
This month we’re blockin’ spam, stylin’ type, 
crossfadin’ tunes, autoplayin’ QuickTime, 
emailin’ via Unix, and more. 

72 Run Ubuntu Linux on 
Your PowerBook
Ready to join the Linux 
revolution? Here’s how 
to install Ubuntu Linux 
on your PowerBook. 
by Robert Strohmeyer

features

how to
76 Soup Up Safari
We show you our favorite Safari tricks and add-
ons, so let’s go Web surfi n’ now (everybody’s 
learnin’ how). by Niko Coucouvanis

78 Light a Fire under Firefox
Firefox is great on its own, but you can trick it 
out with customizable 
extensions to suit 
your needs. 
by Niko Coucouvanis

21 The Best Things 
in Life Are…Free!

31 Introducing
Next month, your favorite Mac magazine will get even better! Check out an exclusive preview of 
Mac|Life and see how we’ll cover news, reviews, and how-to articles you won’t fi nd anywhere else. 
by the editors of Mac|Life

42 Walkin’ in a 
Wi-Fi Wonderland
Wireless networking is the bee’s knees…when it works like it’s 
supposed to. This month’s Field Guide contains the specs and 
hardware you need to know. by Niko Coucouvanis

Cheapskates (and their bank accounts) rejoice! With our 
guide to fi nding free stuff for your Mac, you’ll be good to 
go while saving dough. by Dave Hamilton

 The Best Things 
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 FONT BOOK 
APPLESCRIPT
You can print 
font samples 
from Font Book 
with the help of an AppleScript 
located in /Applications/
AppleScript/Example Scripts/
Font Book/Create Font Sample. 
From Reviews, p54.

 DON’T LOSE YOUR 
LOOSE SCREWS
When taking a notebook apart, 
it’s essential to remember 
which screws go where. As you 
remove them, tape the screws 
to a piece of paper and label 
them with their exact location. 
From “Upgrade Your MacBook 
Pro’s Hard Drive,” p38.

 PICK YOUR FORMAT
You can’t change Tiger’s 
default format for capturing 
screenshots (PNG), but you 
can press Command-Control-
Shift-3 (or 4) to send shots 
to the Clipboard, then paste 
them into Preview and choose 
a format in the Save As dialog. 
From Ask Us, p70.

 TEN-FINGER TEXTING
Keep up with your text-happy 
friends without succumbing 
to thumb cramps—the handy 
WataCrackaz AutoSMS 
extension for Firefox lets you 
send text messages right from 
your Web browser to your pals’ 
cell phones. From “Light a Fire 
under Firefox,” p78.

QUICK TIPS
FROM THIS MONTH’S ISSUE

11 Editors’ Page
New name, new look, new size, new Web site, new editor-in-
chief...get all the “news” about our transformation to Mac|Life.

13 Get Info
Get the scoop on the newest Apple products, Adobe’s 
Soundbooth audio-editing app, a germ-fi ghting mouse, 
the latest graphics and publishing apps, and a clickwheel-
controlled fl ip phone that opens itself.

45 Reviews
46 15-inch Core 2 Duo MacBook Pro notebook Mac
62 Audioengine 5 speakers
60 Avid Xpress Pro 5 video-production software suite
63 B-Flex USB speaker
55 Blinkit iPod light
54 Bravo SE Disc Publisher optical-disc publisher
54 FontVista 3.5 font catalog software
56 imagePROGRAF iPF5000 wide-format printer
55 Intuos3 4x6 wide-format tablet
36 iPod shuffle digital-music player
58 i-Station 3 iPod speaker
63 iSuperCharger iPod charger
37 K100D SLR camera
49 Little Big Disk 320GB portable hard drive
50 MindManager 6 mind-mapping software
50 NovaMind 3.2 mind-mapping software
57 Photosmart R967 point-and-shoot camera
48 Picture Porter Elite digital-media viewer
58 Silver Portable 80GB Dual portable hard drive
37 TubeSock YouTube video-converter software

65 Games
68 Arcadrome game news
66 Bone Act One: Out from Boneville game news
68 Mountain Tanks game news
66 The Sims 2: Open for Business game review
65 Torque Game Engine 1.5 game news
65 World of Warcraft: The Burning Crusade 

coming soon

86 Log Out
86 Letters
Behold the iPumpkin, the best mouse for 
arthritis sufferers, the return of Mr. T, and 
the most expensive mouse pad of all time.

87 Contest
Two prizes are better than one, so we’re 
giving away a copy of Microsoft Offi ce 

2004 Professional Edition and a 
Microsoft Wireless Laser Desktop 
for Mac. 

88 Shut Down
Raise a glass to the illustrious Max 
as he enters his golden years.
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INCLUDING: Microsoft Office 2004 Test Drive
with money-saving rebate offer!

6262MAC 
APPS!

13 Games • 13 Productivity Enhancers 
           • 11 Utilities • and more!

In honor of this month’s cover feature, 
“The Best Things in Life Are...Free,” p21, 
we’re highlighting three nifty freeware 
apps that appear on this month’s Disc—
and if they don’t fl oat your boat, we also 
have a slew of addictive games, a passel 
of useful utilities, a bevy of powerful 
productivity tools, and more. We also have 
the Microsoft Offi ce 2004 Test Drive and 
a rebate form that can save you up to 100 
bucks. Who loves you, baby?
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CoverScout 2.2.1 trial
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MusicRenamer 
freeware
Add order to 
your music fi les 
by easily—and 
consistently—renaming 
the oddball ones with this 
slick utility.

ChocoFlop  
freeware
ChocoFlop taps directly 
into Mac OS X’s Core 
Image technology to work 
graphical 
magic on 
your image 
fi les.

Opera    
freeware
Sure, most browsers are 
free—but few have all 
the features of this one. 
Thumbnails of 
tabbed pages, 
anyone?
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MacAddict is about to undergo a stunning 
transformation. Our next issue will be 
bigger, thicker, and redesigned from the 
ground up to include new sections and a 
design scheme as gorgeous and intuitive as 
our beloved Macs and Mac OS X. We’ll also 
have a new name: Mac|Life.

Mac|Life is the natural next step for 
MacAddict. When MacAddict was born 125 
issues ago, we Mac addicts were a scrappy 
bunch, fi ghting against the seemingly 

unstoppable peecee juggernaut. We viewed ourselves proudly as Apple’s 
Department of Defense. 

But a funny thing happened in the Mac-versus-PC wars. We won. 
Today, Apple’s Macs and iPods are unquestionably the world leaders in 
quality, value, and style. What’s more, with Apple’s domination of both 
the creation and enjoyment of digital entertainment, our Macs and iPods 
have become the centers of our digital lives.

Hence, Mac|Life. As has MacAddict, Mac|Life will help you get the 
most out of your Mac. In fact, Mac|Life will preserve all the elements 
of MacAddict that you’ve come to enjoy, rely upon, and learn from. Our 
tutorials will continue to show you how to squeeze every last drop of 
power and pleasure from your Mac and its software. Our reviews will 
remain authoritative and thoroughly unbiased. Every Mac|Life page will 
both inform and entertain—and do so with a style and elegance that’ll 
put a smile on your face.

Turn to page 31 of this issue for a nine-page taste of the future. Note 
that the news, reviews, and tutorials that you’ll fi nd in this Mac|Life
sampler are real, but the table of contents isn’t—it’s there to give you an 
idea of what kind of articles to expect beginning in February 2007. 

One other improvement: We’ve added a new member to our editorial 
crew, Leslie Ayers, who’ll head up the Mac|Life team as its new editor-
in-chief. Leslie comes from a strong technology-publishing background, 
including stints at Wired News, Smart Business, and PC Computing. 
I’m still on the team, but I’ve chosen to head up MacLife.com—it’ll go 
live right after Steve Jobs fi nishes his Expo keynote speech on January 
8, 2007.

Steve has said that 2007 is going to be the best year in the Mac’s 
history. We say that it’ll also be the best year in Mac magazine history.

   Enjoy,

Say Hello to

What makes you unique? (You know, aside from your inexplicable obsession with kettle corn.) No two Mac|Life readers are 
alike, so why should your Macs be? We’ll show you how to personalize your Mac so it suits you to a T. Expect to learn tons 
of software tweaks, secret shortcuts, hardware mods and upgrades—and more! We’ll also round up the cream of the 
digital camcorder crop—and help you decode digi-video lingo. And you’ll learn how to fi x fuzzy cell-phone photos, set 
up a RAID on your Mac Pro, and master special effects in iMovie. But why stop there? We’ll also test and rate Canon’s 
HV10 high-def camcorder and the RoverTv portable DVR, among many other cool new products.

comingsoon:February2007
Here’s what our editors are preparing for the premiere issue of Mac|Life. 

STAFF RANTS
Q. What’s your favorite thing about Mac|Life?

Max  CARD-CARRYING AARP-ER
What’s your favorite thing about Mac|Life?
My future, blessed with comfortable tan Sansabelt 
Traveler pants, black Jobst for Men Over-the-Calf 
Moderate-Support stockings, Milano Memphis-Mocha 
Suede Soft-Footbed Birkenstocks, and an understated 

Orbit Lounge Rayon Hawaiian Shirt from Banana Jack. Yes, I’m 
moving on to the land of shuffl eboard, electric golf carts, and palm 
trees—check out my retirement party on page 88.

Peter Marshutz  REBORN
What’s your favorite thing about Mac|Life?
My favorite thing about Mac|Life is the new look-and-
feel; it’s stylish, fun, colorful, exciting, and surprisingly 
refreshing. 

Susie Ochs  HOORAY FOR EVERYTHING!
What’s your favorite thing about Mac|Life?
For me it’s a tie between the increased page count and 
how great it’s going to look. I can’t wait until people can 
fi nally see it! 

Roman Loyola  PIPE|DREAMER
What’s your favorite thing about Mac|Life?
My favorite thing was the original Mac|Life style guide, 
which called for the replacement of all spaces in text 
with the Unix pipe (aka “|”). But copy-edit traditionalist 
Susie would have none of it. The|pipe|will|prevail(bang)

Mark Rosenthal  BA-BAR
What’s your favorite thing about Mac|Life?
I’m quite fond of that little bar that separates the words 
Mac and Life. It’s very mysterious in its own way. Bar 
code? Candy bar? Prison bar? Bar-nacle? (For the 
seafaring.) Re-bar? Bar-B-Q? Meet me at the bar? And, 

of course: “Bye. Have a great bar!”

Niko Coucouvanis  MR. UNFURNISHED BASEMENT
What’s your favorite thing about Mac|Life?
I dig everything about the new digs, so I’ll tell you my 
least favorite thing: The fact that nobody else wanted 
to call the front newsy section “Command-O.” Get it? 
Commando? Heh, heh, heh...



Going to Macworld Expo this January?
Stop by booth 602 and say hello.

OmniGra�e • OmniOutliner • OmniWeb • OmniPlan • OmniDazzle • and more
The Omni Group

www.omnigroup.com

Stand in 2-hour line for keynote
Eat overpriced hot dog
See what's new from the Omni Group
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A
bout three months after Intel 
introduced its Core 2 Duo 
processor, Apple unveiled 
the newest generation of 

MacBooks and MacBook Pros—just in 
time for the holiday shopping season. 
The Core 2 Duo replaces the Core Duo 
processors used in the first generation of 
the Intel-based Mac notebooks.

MacBook. Known in the geekosphere 
under its code-name, Merom, the Core 
2 Duo in the new $1,099 MacBook has 
a 2MB L2 cache, while the $1,299 and 
$1,499 MacBooks use a 4MB L2 cache. 
The MacBooks can hold up to 2GB of 
RAM, which you should get if you can 
afford it. Since the MacBook’s graphic 
subsystem shares its memory with 
the main memory, the more RAM you 
have, the better. As with the previous 
generation of MacBooks, the high-end 
model comes in black while the midrange 
and entry-level MacBooks are encased in 
white. Check out the chart below for the 
complete specs.

MacBook Pro. The Core 2 Duo 
processors in the new MacBook Pros use 
a 4MB L2 cache, twice as big as the 2MB 
L2 cache in the Core Duo MacBook Pros. 
The new MacBook Pros can support up 
to 3GB of RAM (one 1GB SO-DIMM and 
one 2GB SO-DIMM; the MacBook Pro has 
two SO-DIMM slots), a boost from the 
2GB limit in the Core Duo MacBook Pro. 
According to Apple, a hardware limitation 
in the Intel platform chipset prevents 
the new MacBook Pro from addressing 
4GB of RAM (a pair of 2GB SO-DIMMs). 
Apple’s Core 2 Duo iMacs have a similar 
limitation (see Reviews, Dec/06, p44).

Apple introduced three different 
models of the MacBook Pro; see the 
chart for their specs. One built-to-order 
option that was available with the old 
15-inch MacBook Pro but is now gone 
is the 7,200-rpm 100GB hard drive (you 
can still get a 7,200-rpm 100GB hard 
drive with the new 17-inch MacBook Pro, 
which actually reduces the standard 
price by $100). Chances are that 

unless you’re editing video or audio, or 
performing graphical renders that last 
longer than a bathroom break, the 5,400- 
and 4,200-rpm drives that come with the 
new MacBook Pro will be fast enough. 
For the both 15-inch MacBook Pros, 
you can upgrade to a 5,400-rpm 160GB 
hard drive for an additional $100, or a 
4,200-rpm 200GB hard drive for $200. 
Upgrading to the 200GB hard drive on 
the 17-inch MacBook Pro adds $100.

FireWire 800 is back on the new 
MacBook Pro. Each model has a single 
FireWire 800 port; the previous 15-inch 
MacBook Pro didn’t have FireWire 800. 
Other expansion options are a FireWire 
400 port, two USB 2.0 ports (three USB 
2.0 ports on the 17-inch MacBook Pro), 
and an ExpressCard/34 slot. 

Just how fast are the new MacBook 
Pros? We got a 15-inch MacBook 
Pro with a 2.33GHz Core 2 Duo 
processor, and we’re happy with the 
improvements—turn to page 46 to see 
our complete review.—Roman Loyola

Dynamic Core 2 Duo
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Apple’s MacBook and MacBook Pro get upgraded with Intel’s Core 2 Duo processors.

They just keep getting faster and faster. Yay!
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13-inch White 
MacBook

1.83GHz Intel 
Core 2 Duo

667MHz 512MB 
(two 256MB SO-DIMMs)

60GB 
(5,400 rpm)

24x Combo drive 64MB Intel 
GMA 950

$1,099 

13-inch White 
MacBook

2GHz Intel  
Core 2 Duo

667MHz 1GB 
(two 512MB SO-DIMMs)

80GB 
(5,400 rpm)

6x double-layer 
SuperDrive

64MB Intel 
GMA 950

$1,299 

13-inch Black 
MacBook

2GHz Intel  
Core 2 Duo

667MHz 1GB 
(two 512MB SO-DIMMs)

120GB 
(5,400 rpm)

6x double-layer 
SuperDrive

64MB Intel 
GMA 950

$1,499 

15-inch  
MacBook Pro

2.16GHz Intel  
Core 2 Duo

667MHz 1GB 
(single SO-DIMM)

120GB 
(5,400 rpm)

6x double-layer 
SuperDrive

128MB ATI Mobility 
Radeon X1600

$1,999 

15-inch  
MacBook Pro

2.33GHz Intel 
Core 2 Duo

667MHz 2GB 
(two 1GB SO-DIMMs)

120GB 
(5,400 rpm)

6x double-layer 
SuperDrive

256MB ATI Mobility 
Radeon X1600

$2,499 

17-inch  
MacBook Pro

2.33GHz Intel 
Core 2 Duo

667MHz 2GB 
(two 1GB SO-DIMMs)

160GB 
(5,400 rpm)

8x double-layer 
SuperDrive

256MB ATI Mobility 
Radeon X1600

$2,799 
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 NEW STUFF

4SIX-STRING SYSTEM
GuitarBox and GuitarBox Pro
$495.95 and $695.95, respectively
www.m-audio.com
Available: Now
M-Audio combines its Black Box 
interface and Pro Tools M-Powered 
production software into a recording 
system for guitarists. The Pro 
version includes more software 
plug-ins.

4GERM-FREE MOUSE
Germ Free Wireless Laser Mouse
$39.95
www.iogear.com
Available: Now
IOGEAR’s new laser mouse features 
a body with a titanium dioxide and 
silver nano-particle compound 
coating, which prevents yucky 
germs and bacteria 
from living on the 
mouse.

For guitar players only.

.MAC MAIL’S NEW LOOK
If you haven’t subscribed to .Mac because you hate the .Mac Mail interface, then you’ll 

be happy to know that .Mac Mail now has a whole new look. In fact, it’s one you’re 
probably familiar with—it looks just like Apple’s Mail app. Not only are the top buttons 
similar, but the left source column is similar also. The improvements go underneath 
the surface, too; .Mac Mail now lets you drag and drop messages into a folder, and you 
can use keyboard shortcuts. Unfortunately, .Mac Mail still has a limited search function 
(you can’t search mail content), and there’s no junk mail fi lter, but you can still use the 
Mail app to access your .Mac Mail.—Roman Loyola

.Mac Mail 
(top) looks like 
Apple’s Mail 
application 
(bottom).

iMAC, MAC PRO 
GET STORAGE 
BOOST
W ithout any fanfare, Apple has 

made available the option to 
buy a 24-inch iMac or a Mac Pro with 
a 750GB hard drive. The 750GB hard 
drive option adds $399 to the 24-inch 
iMac’s $1,999 standard price. You 
can go hog wild with the Mac Pro and 
fi ll each of its four drive bays with a 
750GB drive, for a total of 3TB (that’s 
terabytes, folks; 1TB equals 1,000GB), 
which will push the Mac Pro from its 
standard $2,499 price to $4,695. If you 
decide to go with a single 750GB hard 
drive, you’ll need to pony up $399—but that’s at press time. 
Check www.apple.com for the current price—hard-drive pricing is more 
volatile than Tom Cruise.—Roman Loyola

Imagine fi lling those four hard drive bays with 
3TB of storage. 

4FREE PHONE CALLS
Skype 2.0 for Mac
Free
www.skype.com
Available: Now
With a broadband 
Internet connection, 
you can make free 
calls to anyone on 
Skype, regardless of 
the operating system 
they’re using. Calling 
anyone who’s using a 
traditional phone will 
cost ya, however.

Hypochondriacs 
can now relax.

Reach out and 
touch someone.
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DROOLWORTHY
Sexy Stuff We Can’t Wait to Get Our Mitts On

Don’t Lose 
This PhoneB
How’s this for indulgent? Bang & 
Olufsen’s Serene ($1,275, 
www.serenemobile.com) has 
a motorized hinge so you don’t 
have to put in the effort of 
actually opening it yourself. 
The inside of the dial ring is 
a clickwheel you can use to 
navigate the phone’s controls.
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Sexy Shelf System C
If you’re familiar with Bang & Olufsen products, then you can’t help but think that iLuv’s i9200 ($249.95, www.i-luv.com) 
seems to have inherited some of B&O’s design DNA. This system has a four-CD changer, AM/FM tuner, alarm clock, and 
iPod dock, and it’s available in black or white.
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Bug of the Month
fix applications that won’t launch

You click on an application, but it 
won’t launch. If you’re lucky, you 

see a bouncing icon in the Dock, but 
often, nothing happens. A number 
of potential solutions exist for this 
problem, ranging from simple and 
relatively quick to more tedious. As 
always, back up your data before 
performing these routines.

Update prebinding  Mac OS X uses a 
technique called prebinding to speed 
up application launches. On rare 
occasions, the prebinding needs to 
be updated. Do this to a problematic 
application before you launch it.
1. Log in as an administrator.
2. Open the Terminal (located in 

/Applications/Utilities).
3. Type sudo update_prebinding 

-root / -force and press 
Return.

4. When prompted for a password, 
enter your admin password and 
press Return. The process may 
take a few minutes, and you may 
see various messages flash by. The 
process is done when the Terminal 
returns to a normal prompt.

5. Type exit and press Return.
6. Launch the application.

activity Monitor. If an app seems to 
be hung, kill the process via Activity 
Monitor (located in /Applications/
Utilities). Launch Activity Monitor and 
select in the list the process associated 

with the application. Click the Quit 
Process button. Launch the application.

preferences. If the two fixes 
above fail, it could be a problem with 
the application’s plist file, where 
preferences are kept. Go to the 
username/Library/Preferences folder 
and search for any plist files associated 
with the problematic application. Drag 
the plist files to the Desktop and then 
try to launch the application, which 
should create new plist files.

Clean cache. A cache file might be 
the cause of your problem. Try using 
a utility such as Tiger Cache Cleaner 
($8.95, www.northernsoftworks.com) 
to perform system cache-deletion 
routines. 

It’s a new world we live in. With all the new technology at our disposal, we can make and distribute our own video works of art. 
Democracy Player connects to over 700 Internet TV channels, and the app acts like a VCR for this wealth of digital content. Democracy 

Player does the downloading, you do the watching. Here’s to less exercise and more TV!—Andrew Tokuda

shareware pick of the month

Democracy Player www.getdemocracy.com Free

 When you launch democracy player, you’ll 
see a few popular channels from which to 
download content. the blue numbers tell you 
how many programs are available; click on one 
to start watching.

2   Videos can take up a lot of hard drive space. 
Open democracy player > preferences, click 
the disc Space icon, and check the checkbox. 
this way, democracy player won’t download if 
you’re down to a gigabyte of hard drive space 
(or whatever size you specify).

3  back to downloading programs: Click the 
blue down arrow for the program you want to 
download.

 4  While a download is progressing, you can 
look for more channels. Click the Channel 
guide in the upper-left panel to bring up a 
directory. Subscribing is as easy as clicking 
the green +add button.

5  after democracy downloads a 
program, you can click the green 
play button to play the video 
within the democracy screen.

6  Make sure you have a lot 
of popcorn, because there are 
thousands of programs to watch.
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Think of all that you rely on your com-
puter for: personal and business fi les, 
fi nancial information, broadband access, 
videos, photos, music, and more. 
Increasingly, computers are the hub for 
managing our lives. And more people 
rely on APC to protect their hardware 
and data than any other Uninterruptible 
Power Supply (UPS) brand.

Why is APC the world’s best selling 
power protection? For 20 years, we 
have pioneered power protection 
technology. Our Legendary Reliability®

enables you to save your data, protect 
your hardware, and prevent downtime. 
It also guards against a power grid that 
is growing less reliable every day.

According to the Department of Energy, 
electricity consumption will increase by 
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3.   Download your FREE informational 
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Problems”.
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40% over the next 10 years. Yet today, 
investment in utilities is at an all-time 
low. It’s a “perfect storm” for computer 
users, one that makes APC protection 
even more essential.

APC has a complete line of power 
protection solutions to suit a range 
of applications. Already an APC user? 
Get the latest Replacement Battery 
Cartridge for your unit or upgrade to 
a newer model.

Back-UPS® ES 550R

Back-UPS® ES 750

Smart-UPS® 1000

“Overall the reliability of 
electrical systems in the US 
almost certainly will decline 
over the next 10 years.”
- Venture Development

Find out why 30 million people don’t 
need to worry about losing their 
music, photos, and financial files.

Find APC power protection products at:

Visit www.apc.com/promo Key Code p932x 
Call 888-289-APCC x6959
or Fax 401-788-2797

APC Smart-UPS® 1000 provides 
power protection and battery 
back up during power outages.
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•Freeverse’s 
Lineform 1.2.3
($79.95, www
.freeverse.com) is 
a vector drawing 
and design app. 
The new version 
has better image 
handling, improved 
SVG support for 
inline images, 
better color 
management, 
rasterizing at 
higher resolutions, 
and more.

•Nemetschek’s 
line of VectorWorks 
software has 
been upgraded 
to version 12.5. 
The software 
includes Architect
($1,395, www
.nemetschek.net), 
Designer ($1,795), 
Fundamentals

ArtixScan M1: 
Microtek’s new 
scanner.
v
($995), Landmark ($1,395), Machine 
Design ($1,395), and Spotlight ($1,395). 
A host of improvements includes new 
drafting tools and drawing modes.

•Martin Wengenmayer’s Cheetah3D 
3.5 ($99, www.cheetah3d.com) is a 3D 
modeling and rendering app. It now has 
new animation hot keys, and it can load 
PSD textures, among other new features.

•Microtek’s ArtixScan M1 ($699, 
www.microtekusa.com) is a fl atbed 
and fi lm scanner. It has a 4,800-dpi 
resolution and 16-bit digital output per 
channel. It uses Emulsion Direct Imaging 
Technology, which uses a fi lm tray 
underneath the fl atbed glass to scan fi lm.

•Quark Interactive Designer ($199, 
www.quark.com) is a Quark XPress add-
on that lets you create Flash layouts.

•DTP Tools’ Page Control ($59, 
www.dtptools.com) is an InDesign plug-in 
that lets you create different page sizes 
within a single InDesign project.

•Epson’s Stylus Pro 3800 ($1,295, 
www.epson.com) is a wide-format 
printer that supports media up to 
17 inches wide. The printer can 
automatically switch between photo 
and matte black inks, and it has a new 
screening algorithm to create better-
looking output than previous Epson 
wide-format printers could.
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SEEING RED
Apple’s newest iPod nanos help fi ght AIDS.

Besides black, silver, blue, green, and pink, the iPod 
nano now comes in red, but the red iPod nano is 

special. Dubbed the iPod nano (PRODUCT) RED Special 
Edition ($199 for 4GB, $249 for 8GB, www.apple.com), this 
nano was created to support the Global Fund to fi ght AIDS 
in Africa. For each RED nano sold, Apple contributes $10 to 
the Global Fund. “Now customers can buy the best music 
player in the world and do something to help the world 
at the same time,” said Apple CEO Steve Jobs in a press 
release. Apple is also offering an iTunes (PRODUCT) RED 
gift card, available at the iTunes Store.

For more information about the Global Fund, visit 
www.theglobalfund.org. More information about other 
(PRODUCT) RED products from companies such as 
The Gap, Motorola, and Converse can be found at 
www.joinred.com.—Michelle Victoria

Buy an iPod, 
help fi ght AIDS.

Sure, ifrogz’s Tadpole ($24.99, 
http://ifrogz.com) is cute, and 
your kids will love the big, grippy 
handles. However, none of the 
parents on the MacAddict staff 
would ever let their kids lay their 
hands on their precious ’Pods. It 
turns out that the handles are also 
very useful for grown-ups—during 
a recent retirement bash (see 
p88), the DJ went overboard on 
the bubbly (ahem…Roman…), and 
welcomed the extra help to hold 
onto his stereo-attached iPod. Said 
DJ promises to behave at the next 
party.—Michelle Victoria

iPOD CASE 
OF THE MONTH

SUBMIT YOUR CASE Whether your iPod case is a 
custom-made one-off or mass produced, you can submit 
it for Case of the Month consideration—just send it to 
iPod Case of the Month, Mac|Life, 4000 Shoreline Ct., Ste. 
400, South San Francisco, CA 94080. Please note that we 
cannot return cases.

Made for li’l hands.

NEW ADOBE APP 
MAKES NOISE 

Adobe added a new application for 
audio editing to its multimedia 

line: Adobe Soundbooth (price to 
be determined, www.adobe.com), 
which competes directly with Apple’s 
Soundtrack Pro, part of Apple’s Final 
Cut Studio suite ($1,299, www.apple
.com). Soundbooth is designed for 
video editors who aren’t necessarily 
professional audio editors—the app 
uses interface elements familiar to 
users of Adobe After Effects and 
Adobe’s other video-production 
applications, and it includes not only 
advanced and easy-to-use editing 

capabilities, but 
also a powerful 
music auto-
composition 
mode. Adobe 
is offering a 
free beta of 
Soundbooth 
that’s open 
to the public 
through 
February 

28, 2007, at http://labs.adobe 
.com/technologies/soundbooth. 
Adobe currently expects to release 
Soundbooth in the middle of 2007.
—Roman Loyola

Sorry, PowerPCers: 
Adobe Soundbooth is 
for Intel Macs only.
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If you’ve got money burning a hole in 
your pocket, you’re in the wrong place. 
You won’t need it for today’s journey, 
as we tour through a Queen Mary–
sized boatload of free stuff just for you 
and yours (your Mac, that is). We’ve got 
software, support, services, music, and 
more. This is one roundup that you’ll 
want to read again while sitting at your 
Mac, ready to check out each and every 
item that sparks your interest. So strap 
in, buckle down, and enjoy. 

All these goodies 
have the low, 
low price of 

absolutely 
nothing.☛

PLEASE PAY  THE AMOUNT SHOWN:
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The Best
Things
Life

in 

F R E.E !
by Dave Hamilton
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VLC Media Player 0.8.5 HandBrake 0.7.1 Audacity 1.3.2 beta Flip4Mac GarageBand 
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Productivity
If you can’t be productive with your Mac, you can’t 
justify buying a new one. Use these nuggets when you 
need to quit wasting time and get stuff done.

Quicksilver b51  Launcher on steroids…and acid
Get it: www.blacktree.com  You need: Mac OS 10.4 or later

Forget what you know about finding and launching documents 
and apps. Once you grok the way Quicksilver does its magic, 
you’ll amaze yourself with how you can simply type a few quick 
keystrokes to magically make your Mac do your bidding.

NeoOffice 2.0 Aqua Beta 3  Free replacement for 
Microsoft Office
Get it: www.neooffice.org  You need: Mac OS 10.3 or later

Based on the OpenOffice.org code base, this package includes 
replacements for Microsoft’s Word, Excel, PowerPoint, Access, 
and Draw. NeoOffice takes it all one step further and makes a 
fully Mac-ified experience, so you don’t need X11 or anything 
else to make it work—and yes, it reads and writes MS Office file 
formats natively. Dude, it’s free—go get it.

TextWrangler 2.1.3   BBEdit’s (mature) little brother
Get it: www.barebones.com  You need: Mac OS 10.3.5 or later

Need to edit text files on an FTP server, rewrap a busted-up 
email, sort a list of names, or even write some HTML, Perl, or 
PHP? Go get TextWrangler. Based on Bare Bones Software’s 
BBEdit engine, TextWrangler is one of the most valuable pieces 
of freeware you’ll ever leech down to your computer. It’s not 
often you get software this good for free, folks. 

One of the best things about the Mac is the quantity—and quality—of free software available. 
Indeed, it’s possible to make it through your day using software that won’t set you back a dime. 

Before you dig into these free goodies, however, it’s good to know a few things. First and 
foremost, free often means more than just “cost-free”; it usually means “free from support” as 
well. And then there’s freeware that’s actually donationware, which comes from a developer who’s 
continuing to improve it and requests that happy users make a donation to support that effort. If 
you’re looking for support, a donation is an excellent way of getting a developer’s attention. 

We’ve compiled a list of our favorite freeware apps, but there are thousands more where these 
came from—check out VersionTracker (www.versiontracker.com), MacUpdate (www.macupdate 
.com), and FreeMacSoftware.com (you can figure out their URL on your own) to find more.

Use Quicksilver to launch any app or open any file on your Mac.

NeoOffice works so well that we wrote parts of this article with it.

TextWrangler lets you edit and manipulate text in many  
different ways.

Software

☛
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Utilities
We all need to keep our Macs running 
smoothly, and these free utilities are the 
key to getting—and staying—there.

MenuMeters 
Compact, thorough system-activity 
monitor
Get it: www.ragingmenace.com  
You need: Mac OS 10.2 or later

With MenuMeters, you can easily see  
what your Mac is up to.

Something that should simply be 
included with Mac OS X, MenuMeters 
is an excellent way to monitor your 
system’s health and status. This System 
Preference pane allows you to put disk, 
CPU, memory, and network usage 
graphs and readouts in your Mac’s 
menubar, giving you at-a-glance access 
to vital system stats.

OnyX 1.7.5
Multifunctional Mac OS X  
maintenance utility
Get it: www.titanium.free.fr 

You need: Mac OS 10.1.5 or later

Use OnyX to help keep your Mac clean and 
running well.

OnyX is a must-have utility for any Mac 
OS X user. Allowing you to run all of the 
standard (and some not-so-standard) 
system maintenance tasks, clean your 
Mac’s caches, and even customize your 
Mac-using experience, OnyX will help 
keep your Mac running smoothly.

Mactracker 4.1b1
Details about every Mac (and clone)  
ever released
Get it: www.mactracker.ca 
You need: Mac OS 10.3.9 or later

A whopping 16MHz in 1989—how did we 
ever survive?

The next time your old college roommate 
calls and asks you what kind of memory 
she needs to upgrade her Power 
Computing PowerCenter Pro, you’ll 
have the answer right at your fingertips, 
thanks to Mactracker. You could even 
use this to host a Mac geek party and 
play all the startup chimes from every 
Mac ever made. The fun never stops!

Firefox 2.0
Customizable, standards-compliant  
Web browser
Get it: www.mozilla.com

You need: Mac OS 10.2 or later

Firefox gives you ultimate browsing 
flexibility.

If you want to trick out your browser, get 
Firefox—it’s so hip and customizable, 
it can be your low-rider and monster 
truck at the same time. From weather 
status to Web-design help to themes 
that customize the look of your browser, 
there are thousands of add-ons to make 
Firefox more fun and more useful—check 
out p78 for some of our favorites.

Cyberduck 2.6.2
Mac-savvy FTP utility
Get it: http://cyberduck.ch

You need: Mac OS 10.3.9 or later

Use Cyberduck to manage all of your FTP 
connections. 

Certainly, Mac OS X has a few built-in 
ways of using FTP, but none of them 
are as easy to use as Cyberduck. From 
Bonjour support to Spotlight integration, 
this app speaks fluent Mac. It’ll even 
hand text files back and forth with 
TextWrangler (p22)—that’s a can’t-miss 
freebie twofer!

Chicken of the VNC 2.0b4
Remote desktop control
Get it: http://sourceforge.net/projects/cotvnc

You need: Mac OS 10.3.9 or later

 

Use VNC to see and control the desktop on 
other Macs—or even Windows or Linux 
machines. 

Ever need to control another Mac across 
the country (or even across the room) 
but you’re too cheap to pop the $299 (10 
systems) or $499 (unlimited systems) 
for Apple’s Remote Desktop? Well, by 
enabling VNC support in Mac OS X Tiger 
and downloading Chicken of the VNC, 
you can do it all without spending one 
thin dime.

Internet
Having a Mac that’s not connected to the Internet is like running a three-legged race  
with only two legs. Er…um…well, it’s just not as fun. 

☛
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VLC Media Player 0.8.5
Multiformat movie and audio player
Get it: www.videolan.org

You need: Mac OS 10.3.9 or later 

VLC plays movies that QuickTime Player 
won’t.

VLC picks up where QuickTime Player 
leaves off. There are plenty of video 
formats that just don’t play properly in 
QuickTime, and for those (and others), 
VLC is your go-to app. 

HandBrake 0.7.1
Rip DVDs to your Mac or iPod
Get it: http://handbrake.m0k.org

You need: Mac OS 10.3.9 or later

Handbrake’s interface doesn’t look pretty, 
but the movies it creates sure do.

Just pop your DVD into your Mac, and 
HandBrake will convert it to a file 
playable by QuickTime or on your iPod. 
Just make sure you’re not breaking the 
law when you do it, OK?

Audacity 1.3.2 beta
Full-featured audio editor
Get it: http://audacity.sourceforge.net

You need: Mac OS 10.3 or later

Support for multiple file types makes 
Audacity a real workhorse.

With Audacity, you can easily take audio 
files, edit them, cut them up, stitch them 
together, and even record them from 
scratch. Audacity now supports Audio 
Units plug-ins, as well.

Flip4Mac
Play Windows Media (WMV) files in 
QuickTime Player
Get it: www.microsoft.com

You need: Mac OS 10.3.9 or later, QuickTime 

6.5 or later

Use this to play those pesky Windows 
Media files on your Mac. 

This great piece of software allows you 
to easily play Windows Media files right 
inside of QuickTime Player. Note that 
Flip4Mac doesn’t support protected 
files—those are only playable inside 
Windows itself.

GarageBand 
Plug-ins
One of the cool things about GarageBand 
is that you can customize it with 
additional plug-ins and instruments. 
We’ve provided a couple of our favorites 
here, but if you want more, visit sites 
such as macmusic.org or www.hitsquad 
.com/smm/mac/PLUGINS_AU and 
customize your own GarageBand library. 

Crystal 2.4.9
Software synthesizer
Get it: www.greenoak.com/crystal

You need: Mac OS 10.3.9 or later

Tweak to your ear’s content.
The next time you get a hankering to 
create that perfect synth sound for 
your space odyssey, there’s a good bet 
Crystal can help. This multitimbral synth 
provides almost limitless possibilities 
from which you can create the perfect 
soundtrack for when the Ewoks are 
being eaten by Mothra.

MDA Free AU Effects,  
Sept. 2005 Edition
A series of free effects for GarageBand 
and more
Get it: http://mda.smartelectronix.com

You need: Mac OS 10.3.9 or later

Set it, forget it, and just jam, man.

Whether you want to be Jan Hammer 
with a ring modulator, Joe Walsh with 
a great talk box, or Jimmy Smith with a 
Leslie, this free bundle of effects is an 
awesome place to start.

Audio & Video
The Mac rocks when it comes to audio and video stuff, and these apps will make sure 
that you rock right along with it. 

☛

Software  continued
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Genius Bar
If an Apple Store happens to have 
sprouted up near your house, you can 
take advantage of the Genius Bar. And 
the name is accurate—these folks can 
be of help with everything from fixing 
your malfunctioning Mac to showing 
you the ins and outs of GarageBand. Go 
online to www.apple.com/retail to make 
an appointment (or simply call the store 
directly if your Mac is too sick to get 
online) and then head on in. Regular Joe 
customers can reserve appointments the 
day of, but a $100 ProCare card gets you 
14-day advance access to appointments. 
In hella-busy markets such as New York 
or San Francisco, that may be the best 
100 bucks you’ll ever spend.

MUGs
MUGs—Mac User Groups—are great 
resources. Your local MUG is a network 
of fellow Mac users with whom you can 
share tips and all sorts of Mac geekery. 
If you’re not sure what’s available near 
you, visit www.apple.com/usergroups  
to find your closest MUG.

Help on the Web
There are a ton of Web sites  where you 
can tap some knowledgeable Mac gurus 
and get answers to your questions. 

Mac Owners Support Group. At 
http://macosg.com you’ll find an Apple-
endorsed online user group full of some 
exceptionally knowledgeable, helpful, 
and active members.

Though the Mac is clearly the most stable computing platform around, 
that doesn’t mean it’s perfect, nor does it mean that we—as Mac owners—
always know how to do everything with our machines. Luckily, you can get 
good support for free if you know where to look.

☛

MacFixIt Forums. Go to www 
.macfixitforums.com and you’ll find 
another great site full of thousands 
of devoted geeks ready to share their 
wisdom with you.

Apple Discussion Groups. Though 
the quality has diminished since Apple 
eighty-sixed all of its paid moderators, 
http://discussions.apple.com still has 
some active volunteers answering 
questions and keeping things moving. 

Podcasts
There are many podcasts dedicated to 
helping you get the most out of your 
Mac. Most of these shows will take 
questions by email as well as voice mail, 
allowing you to phone in a question that 
might get answered on the air. 

MacCast. Though this show definitely 
includes quite a bit of news, it has a 
healthy support aspect to it as well; 
you’ll find it at www.maccast.com.

The Mac Observer’s Mac Geek Gab. 
Hosted by two longtime Mac geeks 
(including your humble author), this 
show often focuses on addressing 
questions sent in by listeners. Take your 
tales of woe to www.macgeekgab.com.

Apple opened Pandora’s box when it let us start audio- and video-
chatting with other Mac users via iChat AV—but the conversation 
doesn’t stop there. A few other apps and platforms have cropped up, 
letting you chat not just with other Mac users, but with folks on all 
sorts of computers.

Skype 2.0
Get it: www.skype.com

You need: Mac OS 10.3.9 or later

If you haven’t already heard of Skype, 
you must not get out much. Simply put, 
Skype not only lets you place voice and 
video calls to other computer users 
(including people using Windows and 
Linux), but also includes a link to the 
“real” world, letting you call U.S.-based 
landlines, as well, all for free—at least 
until the end of ’06. The quality of the 
sound is many times better than that 
of iChat AV, though Skype basically 
requires you to use headphones while 

making calls—it doesn’t hold a candle 
to iChat’s near-perfect speakerphone 
capabilities. That said, Skype is way 
better at dealing with firewalls and 
routers than iChat, and it can be a real 
thing of beauty if you’re in an office 
or hotel that has a funky network. 
Pay options include voice mail, SMS 
messaging, and international calling. 

Gizmo Project
Get it: www.gizmoproject.com

You need: Mac OS 10.3.9 or later

Similar to Skype, Gizmo is a 

crossplatform (Mac, Windows, Linux) 
chat client, though currently it only 
supports audio, not video. Calls to other 
Gizmo users (including to their landlines 
and cell phones) are free, but outgoing 
calls to anyone else’s landline or cell 
will cost you a few cents—a penny per 
minute in the U.S. Gizmo does have echo 
cancellation to make for a more natural 
speakerphone-type experience, and it 
also includes a way of recording your 
calls, which can be quite handy when 
talking to absent-minded coworkers or 
family members.

Gab away—for free—with Skype 2.0.

Support

Voice Calling
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Docs & Spreadsheets
The Google dudes and dudettes know 
their interactive Web stuff. Docs & 
Spreadsheets (http://docs.google 
.com) lets you edit files right in your 
Web browser. You can start from scratch 
or simply upload your existing Word or 
Excel files. You can also collaborate with 

other folks on a single document, and it 
tracks revisions better than Word itself. 

Gmail
Yes, .Mac Mail has a spiffy new interface 
(see p14), but it ain’t free, and it ain’t as 
slick as Gmail (www.gmail.com). With the 
best Web interface around, nearly 3GB of 

storage per account, and Google Search 
to pore through it all, Gmail is one of the 
true gems of the free-stuff-on-the-Web 
world; check it out at www.gmail.com.

Earth Release 4 beta
Perhaps one of the coolest time-wasters 
in history, Google Earth (www.google 
.com/earth) lets you take yourself on a 
tour of basically anywhere on the planet. 
Just type in an address or even the name 
of your favorite restaurant, and though 
the combined power of Google’s search 
engine, satellite images, and maps, 
you’ll be taken there. Then you can float 
around, rotate your view, zoom in and 
out, and really suss things out. You can 
even plan routes and let Google Earth 
“fly” them while you watch.

OK, yeah, we love and hate Google at the same time. It scares the pants off of 
us, too. But if the company is going to rule the world and become Big Brother, 
we might as well enjoy the ride, right? Google gives so much stuff away that 
you’d think all of its engineers work for free. Some of our favorites are:

Google Stuff

Free Web mail has never been so tasty.Edit text and spreadsheets right in your Web 
browser from any computer, Mac or PC.

Not much escapes Google Earth.

☛

Democracy Player 0.9.1
If you’re sick of not finding anything to watch 
on your TiVo, go get Democracy Player (www.
getdemocracy.com) and tap into a huge 
network of shows and shorts available for free 
online. Tell Democracy what shows you want, 
and just like your TiVo, it will download them 
once they’re available, and you can watch ’em 
when you want. (For more info on Democracy 
Player, check out our Shareware Pick of the 
Month on page TK.)
[screenshot: Democracy.tif] 
Expand your horizons by watching free shows 
with Democracy Player.

Pandora
Tell Pandora (www.pandora.com) about music you like, 
and it will create a custom Internet radio station for you. 
Continue rating songs as you listen to them, and soon 
you’ll be in musical bliss. 

eMusic
Even though eMusic (www.emusic.com) isn’t free forever, 
you can still get 25 free tunes from them, and the MP3s will 
work fine on your iPod. Get ’em while they’re hot.

FreeMacMusic
A ton of free music is available on the Web, and the kind 
folks at FreeMacMusic.com can help you find a tasty, 
steaming heap of it.

Is it possible to bag free music without 
supporting the college funds of defense    
lawyers’ kids? Yes, it is. Read on.

Music
Though the RIAA and MPAA have 
done their part to make sure that 
most everyone even thinking 
about downloading music or 
movies from the Web rots away 
in a cold, dark cell (or, at the very 
least, is threatened with such), 
there are plenty of places on 
the Web where you can still get 
free, quality tunes. There are lots 
of artists who’ll happily share 
their music with you for free, in 
hopes of furthering their art and 
expanding their fan base.

Internet Archive. Literally 
hundreds of thousands of audio 
files—including more than 
30,000 concerts—are freely 
available at www.archive.com.

CNET Music. Free streaming 
music from some of your favorite 
artists can be found at http://
music.download.com.

FreeMacMusic. Pop on over to 
www.freemacmusic.com to find 
reviews of and links to music, 
all categorized by genre.

Artist Direct. Music and videos 
from top stars are available for 
your edification and enjoyment 
at www.artistdirect.com.

GoingWare. Check out www 
.goingware.com/tips/legal-
downloads.html to find links 
to thousands of sites that offer 
free music downloads.

Music Downloads ☛☛

When he’s not busy podcasting the Mac Geek Gab or berating his minions at 
MacObserver.com, Dave Hamilton takes his frustrations out on his drum kit.
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TOY BOY: How Rob Swift uses his Mac to design the most mind-blowing toys!
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Creativity!

HOW TO
>Blog from your cell phone
>Create special effects in iMovie
>Master home entertainment lingo
>Rescue files from a dead drive

REVIEWED
>Apple’s tiniest iPod
>Custom shuffle accessories
>Skype vs. SightSpeed
>NEC 19-inch widescreen display
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>>32 THE 
HIDDEN 
POWERS OF 
iLIFE ’07
Apple’s creativity software 
includes undocumented 
features that pump up its 
capabilities beyond 
what you ever thought 
possible. We show you 
how to unlock them all.

    PORTABLE STORAGE  isn’t nearly as humdrum as you 

                might think—especially now that DRIVE MAKERS 

are starting to pay more attention to the appearance 

                  of their GRAB-AND-GO OFFERINGS. 

>>>12  M|L  FEB•07  

Remember the beige box? Mac users have long had much cooler-looking 
alternatives to the drab, putty-colored personal computers of the ’80s 
and ’90s. But only recently have makers of external hard drives put as 

much thought into the exterior design of their products as they put into the 
internal engineering. Of course, we know that a portable drive’s performance has 
absolutely nothing to do with how cool (or uncool) its case is. But we use Macs in 
part because they’re the best-looking computers out there. Why shouldn’t we be 
just as picky about our portable hard drives?

We gathered a group of portable hard drives with a range of storage 
capacities. Then we loaded ’em up with our most storage-hungry fi les to 
determine which ones are as beautiful on the inside as they are on the outside. 

 S T O R A G E
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>46< 
PICK 

ONE UP
There’s more to portable 

hard drives than capacity and 
speed. We test the best-
looking handheld drives 

for your Mac.

 >>>>>>>>>>>>>>>>>>>>>>>>HANDS-ON

There’s more to portable 
hard drives than capacity and 

 S T O R A G E

speed. We test the best-
looking handheld drives 

for your Mac.

 >>>>>>>>>>>>>>>>>>>>>>>>

 COVER STORY >>53 TOY STORY 
Are you ready to play? 
You won’t believe the amazing 
tricks Rob Swift makes his Mac 
do in the course of designing 
the most innovative new toys. 
(Only a Mac user could have 
this much fun at work.)
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The only thing that stands 
between you and the objects 
of your desire is seven feet 
of shatterproof glass.

FEED YOUR 
MIND.

FEAST YOUR 
EYES.

Stifl e the inevitable quips about 

needing a thousand quarters to 

buy a 30GB iPod: The machines 

only take credit cards. And try not to get all 

riled up imagining what you’d do if the last-

available shuffl e got stuck on its way out 

of the chute, because pounding on one of 

these 1,600-pound hunks of metal and glass, 

or attempting to tip it over, is pointless. 

Zoom Systems, the San Francisco company 

behind the ultra-high-tech vending machines, 

assures us that they are engineered to 

deliver products fl awlessly every time. 

(Plus, the goods inside are protected by 

shatterproof glass and security cameras. So 

back off.)

It’s scary how easy it is to part with your 

money: Touch the screen, choose your 

poison, and hit “buy now.” Swipe your card, 

enter your PIN, and wait a few seconds for 

the robotic arm to swish over to your item, 

pick it up, and drop it gently into the slot 

under the touchscreen. Before you can tear 

off the shrink-wrap, out pops a receipt.

Congratulations…you’re so addicted to all 

things Apple that you can’t walk by a vending 

machine—a vending machine—without 

indulging your iPod jones.

Here are 10 tidbits we bet you didn’t know 

about Apple’s answer to instant gratifi cation.

—Leslie Ayers

iPOD VENDING 
MACHINES

>>>10 TASTY FACTS ABOUT.... 

>>>Start
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>>>NUMBERS CRUNCH. 

WE DID THE MATH
There’s a lot of freakin’ code in the new Mac Office.

1. WORTH THEIR WEIGHT  Weighing 1,600 pounds and consuming 30 square 
feet, the digital-music machines’ average sales range from $1,600 to $16,000 per square 
foot. Not bad. The flagship Apple Store in Manhattan averages $4,000 per square foot.

4. FIRST TO MARKET  The first two vending machines selling iPods appeared in 
the Atlanta airport and Macy’s in San Francisco’s Union Square in 2005. 

8. OH, BIG BROTHER  Security cameras monitor the exterior of the machines, 
which constantly send electronic data to the Zoom Systems “nerve center.” The telemetry 
ranges from diagnostics and low-inventory alerts to info on consumer behavior patterns 
and how much receipt paper is left.

7. KA-CHING!  The priciest item sold in any Zoom Systems electronics vending 
machine is the $499 Motorola Q phone. The average purchase is between $85 and $145.

5. LOCATION, LOCATION  The iPod machines can be found in 200 well-trafficked 
locations around the country, including airports, department stores, and even grocery stores.

2. AS SEEN ON TV  Beyond iPods, other electronics, and standard vending-machine 
fare, certain Zoom shops also sell Neutrogena and Proactiv skin-care products. (Late-night 
TV watchers will recognize Proactiv as the three-step acne treatment that gave Jessica 
Simpson her now-perfect complexion.)

10. OH, AND BY THE WAY…  Despite successful sales of Apple products, there’s 
one thing about Zoom Systems’ machines that Steve Jobs probably wouldn’t want you to 
know: They run on Windows.

6. ON THE CLOCK    After you’ve made your selection, the delivery portion of a 
purchase takes an average of 59 seconds. When was the last time you got through any 
checkout lane in less than five minutes?

3. JUST TRY IT    A word to Barry Bonds wannabes: The glass on these machines is 
truly shatterproof, even if whacked with a baseball bat. (The engineers at Zoom Systems 
tell us that they actually tried it.)

A mind-numbing factoid recently popped up on Mac Mojo (blogs.msdn.com/

macmojo), the blog authored by the Microsoft Office for Mac developer team, aka 

MacBU: At last count, there were 30 million lines of code in the new version of Office 

for the Mac. Each MacBU developer is in charge of about a half-million lines, or, as 

the post noted, roughly the equivalent of 35 paperback books’ worth. To help you 

wrap your brain around that total number—30 million lines!—here are a few more 

points of comparison:

30,000,000 lines of code 
are 
roughly 
equal  
to

3 million full-screen text 
messages sent from 

Paris Hilton’s Sidekick t

s A mere six 
volumes out of 
the 20-volume 
Oxford English 
Dictionary

Deep Tech
BY  R I K  M YS L E W S K I

HUNGRY FOR A  
TRIPLE TREAT?
Personal computers have always benefited from 

advancements first developed for “big iron”—

industrial-strength servers such as those that today 

feed the world’s voracious online appetite. YouTube, 

for example, serves 100 million videos each day. Google 

uses an estimated 450,000 servers to handle a billion 

daily search requests. And then there’s the explosion of 

Web 2.0 sites such as Digg, Facebook, Del.icio.us, and 

many more. (After all, it takes an enormous amount 

of computing power to give you instant access to 

everyone who “dugg” a BBC article on blue-jean dye’s 

potentially deadly effect on cancer cells.)

In response, Intel inaugurated its Terascale 

Research Program, an effort to radically boost the 

performance of giant server farms. At the recent Intel 

Developer Forum, the company announced three 

mind-boggling hardware breakthroughs.

The first is an 80-core processor. (And you thought 

your dual-core MacBook was burly.) Each of the 80 

cores in this proof-of-concept chip is a simple math-

only processor—so don’t expect to play Quake 4 at 

light speed anytime soon. What’s important about this 

beastie is, well, that it exists, and that it can process 

1 trillion floating-point math instructions per second, 

what engineer types call a teraflop. 

One of the biggest barriers to maximizing the 

performance of a multicore processor is feeding it 

enough data from memory. The standard scheme of 

accessing memory from DIMM slots over a system bus 

would choke mightily if asked to feed 80 processor 

cores. To solve this, Intel places the processor cores 

directly on top of the memory chips, one slab of RAM 

per core, using thousands of electrical connections. The 

result? The 80-core chip ’n’ RAM array has a memory 

bandwidth of one terabyte per second—that’s about 

100 times faster than your MacBook. 

To feed this puppy with data from the outside 

world, Intel also developed electrically pumped 

silicon lasers that can deliver one terabit of data per 

second down a single optical fiber. Exactly how they 

accomplish this is beyond the scope of this column, 

but the technology is affordable, reliable, and 50 times 

as fast as copper wire.

Intel estimates that it will take five years for this 

technology to find a home in big iron—and when it 

eventually trickles down to your Mac, you’ll be able 

to use natural-language voice commands in games 

rendered in real-time ray-traced image quality.

When Rik gets his 80-core Mac, he’ll use it to 
instantly auto-translate Skype calls to his peeps  
in Poznan into perfect Polish.

The future of processors is 
fast. Breathtakingly fast.

9. PERSONAL EFFECTS    Early on, iPods were sold as part of Zoom Systems’ 
“Hotel 24 concept”—shorthand for machines outfitted with hotel guests in mind. The 
concept had iPods and accessories rubbing elbows with yogurt-covered pretzels, Scope 
mouthwash, and Trojan-Enz condoms.
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If printed out and laid 
end to end, the distance 
between Apple’s HQ in 
Cupertino, California, and 

the Microsoft compound 
in Redmond, Washington 
(852.5 miles door to door, 
if you must know)



Measuring 1.07 by 1.62 by 0.41 inches, the 

sleek, aluminum-encased iPod shuffl e is a 

tiny technological treasure.

The clip opens to just under a half-inch 

wide, big enough to latch it onto a lapel, 

pocket, or backpack strap. The clip could be a tad tighter—

it didn’t take much effort to yank the shuffl e off its mount, 

though it barely budged with natural movement. Using the 

controls when it’s clipped on your shirt or pants pocket is 

effortless, and Apple put an LED indicator light on the top 

and bottom of the shuffl e. Nice touch. (Apple provides a 

cheat sheet to decipher the different LED colors and blinks.) 

You also get a cute li’l USB dock to connect the shuffl e to 

your Mac and sync it with iTunes.

The one major fl aw: Our shuffl e came with the older-

generation earbuds, not the new improved ones. Sure, 

$79 is a bargain—and Apple had to keep the price 

down somehow—but we still felt slightly cheated. And 

audiophiles aren’t going to like one other bit of news about 

the shuffl e: It can’t play fi les encoded in Apple Lossless 

format. So if you’ve ripped your entire music library this 

way, those tracks are off-limits to your shuffl e unless you 

rerip them using standard compression.

The bottom line. If it weren’t for the outdated earbuds, 

the new iPod shuffl e would get our highest rating.

—Roman Loyola

i P O D  S H U F F L E

APPLE’S LITTLEST MUSIC PLAYER

>>>Reviews

iPOD SHUFFLE

COMPANY: Apple  
www.apple.com
PRICE:  $79
REQUIREMENTS:  Mac OS 
10.3.9 or later, iTunes 7.0.2 or 
later, USB

Tiny. Durable 
aluminum casing. 
No display. Ships with old iPod 
earbuds. Can’t play Apple 

Lossless fi les.

TOUGH TESTING, TRUSTED RATINGS

EDITORS’
CHOICE

Mac|Life 
R A T E D

G R E A T
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iPOD
SHUFFLE: 

ACTUAL SIZE
1.07 inches by 

1.62 inches



TRICK OUT 
YOUR SHUFFLE

T U B E S O C K

HANDY VIDEO CONVERTER
TubeSock takes YouTube (www.youtube.com) video clips, reformats them 

for your iPod, and saves them on your hard drive. Simply enter the video’s 

URL at the top of TubeSock’s window. At the bottom of the window, choose 

your format and where to save the fi le. It’s that simple. Too bad TubeSock 

can’t load videos directly to your iPod.

You can make TubeSock an option in Safari’s 

Bookmarks Bar; then you’d just click the Show 

In TubeSock button in Safari to make that video 

appear in TubeSock, ready to reformat and rip.

The bottom line. All apps 

should be as easy to use as 

TubeSock.—James Ellerbeck

Don’t be put off by 
its 6.1-megapixel 
resolution—this is 
plenty of camera for 
the price.

P E N TA X  K 1 0 0 D

SLR FOR FIRST-TIME USERS
Pentax’s K100D SLR camera is so user-friendly it practically smiles when 

it’s powered up. Good ergonomics coupled with a stainless steel chassis 

and a killer price make it an ideal choice when you’re ready to move up to 

a digital SLR camera. 

Although the K100D’s 6.1-megapixel resolution may sound puny in 

today’s 10-megapixel world, we found its resolution to be more than 

enough to roll color-brilliant, tack-sharp images out of our Epson Stylus 

2200. The camera’s stock lens, a smooth-as-butter Pentax f/3.5-to-5.6 

zoom lens with a focal length of 18 to 55mm (27 to 83mm in 35mm 

terms), includes a sunshade and is perfect for general photography. When 

used at its widest focal length, however, slight vignetting (darkening) 

appeared at the extreme corners of the image.

The K100D has a built-in shake-reduction mode that compensates for 

unsteadiness at slow shutter speeds; it also works well for tight zooms 

and extreme close-ups. This feature works with any Pentax lens, and with 

an inexpensive adapter ($25), you can even use earlier screw-in lenses, 

though you’ll need to manually focus and set apertures.

The K100D can take awesome black-and-white infrared pictures—a 

secret not revealed in the otherwise well-written manual. We gave this 

a try by placing a visually opaque Tiffen 87 infrared fi lter over the 

lens. Though we then had to approximate where to aim the 

camera, the K100D was able to focus through the fi lter 

and calculate exposure, and it usually selected 

shutter speeds from 1/6 to 1/30 of a second. 

Most other digital SLRs (if they can shoot IR at 

all) require long exposures and a tripod; with 

the K100D’s shake reduction activated, we 

captured sharp, well-exposed images. 

The bottom line. The K100D is a quality 

camera that’s fun to shoot with and delivers 

superb images, and it’s available at a great 

price.—Arthur Bleich

From YouTube 
to YourMac.

Sporty, earmuff-style 
covers for your earbuds 
let you rock out without 
tuning out traffi c noise. 
SLIPSTREAMZ SLIP 
($12.99, www.slipstreamz.com)

Tame your earbud cables 
with this happy little 
monster, available in four 
colors and even a glow-
in-the-dark version!
TUNEWEAR TETRAN 
($12.95, www.tunewear.com)

Protect your shuffl e with 
a clear, durable shell—and 
keep the cords tidy, too.
MOPHIE MUEVA WRAPTOR 
($10, www.mophie.com) 

ALSO >>> APERTURE 1.5.1 • SKYPE VS. SIGHTSPEED • iYOGA
▲

Mac|Life 
R A T E D

G R E A T

TUBE SOCK

COMPANY: stinkbot 
www.stinkbot.com
PRICE:  $15
REQUIREMENTS:  Mac OS X 
10.3.9 or later, Internet connection

Inexpensive. Easy to use. 
Simple Safari integration. 

Preserves YouTube’s resolution. 
Can’t load clips 
directly to an iPod.

Mac|Life 
R A T E D

G R E A T

PENTAX K100D

COMPANY: Pentax  
www.pentaxslr.com
PRICE:  $699 with 18-to-55mm 
(27-to-83mm 35mm equivalent) 
f/3.5-to-5.6 zoom lens
REQUIREMENTS:  Mac OS 8.6 
or later, Mac OS 10.1 or later, USB

Quality construction. 
Excellent images. Built-in 

shake reduction works with all 
Pentax lenses. ISO to 3,200 for 
extreme low-light photography. 
Uses AA batteries.

Continuous shooting limited 
to four to fi ve frames before 

buffer fi lls. Four-way rocker 
switch not positive enough. Short 
battery life.

EDITORS’
CHOICE
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	 >>>WHAT	YOU	NEED

>>  MacBook Pro ($1,999 and up, www.apple.com)

>>  2.5-inch SATA hard drive, such as a Hitachi 
Travelstar 160GB 5K160 5,400 rpm SATA 
Notebook Drive with 8MB Cache  
($199.95, www.macsales.com)

>>  #0 Phillips screwdriver

>>  T6 TORX screwdriver

>>  Tape and paper, or sticky notepad

We don’t blame you if you’re jealous of your friends who have brand-new Core 2 Duo MacBook Pros—all of which come 

standard with at least 120GB hard drives. There’s no easy way to upgrade your ’Book’s processor (short of starting over 

with a new one), but we can show you how to change out the hard drive for a roomier one.

Before you begin, clear off a work surface at least three times the size of your MacBook Pro and gather the items 

listed below. Back up your hard drive before you start—just in case. To get your apps and data onto the new drive, we 

recommend procuring a SATADock v4 from WiebeTech ($229.95, www.wiebetech.com). After installing the new drive, 

connect your old drive to your MacBook Pro via the SATADock v4 and install OS X. When your ’Book reboots itself, follow 

the Setup Assistant’s prompts to transfer your settings, files, and apps.  BY NIKO COUCOUVANIS

Upgrade Your  
MacBook Pro’s Hard Drive

You’ll get a bigger hard drive and 
a peek under the hood. And yes, 
the screen will be blank when you 
do this, since your MacBook Pro 
will be powered down, unplugged, 
and without its battery.

>>CAUTION<< 
If you’re the type who 

never crosses against the 
light, think long and hard before 
attempting this upgrade. Unless 

you’re an authorized Apple 
service technician, cracking 

open your MacBook Pro 
voids the warranty. 

>>>Create>>>>>>
HOW	TO	DO	ANYTHING	ON	YOUR	MAC

>>>38  M|L  FEB • 07 



 >>>WHAT YOU NEED

>>  MacBook Pro ($1,999 and up, www.apple.com)

>>  2.5-inch SATA hard drive, such as a Hitachi 
Travelstar 160GB 5K160 5,400 rpm SATA 
Notebook Drive with 8MB Cache 
($199.95, www.macsales.com)

>> #0 Phillips screwdriver

>> T6 TORX screwdriver

>> Tape and paper, or sticky notepad

1 Drive Out the Screws
Shut down and unplug your MacBook Pro, and then 

remove the battery. Remove the screws as indicated in the 

photo below—and don’t mix them up or lose them. Tape 

the screws to a piece of paper and label each screw with its 

exact location, or affi x each set of screws to the sticky strip 

on a sticky note, labeling the note. Trust us—when it’s time 

to put the case back together, you won’t be able to tell the 

RAM hatch screws from the side screws, or the long rear 

corner screws from the ones that go in by the RAM riser.

5 Dig Out the Drive
Remove the two screws shown 

in the photo at right and move the 

Bluetooth wad out of the way. Unstick 

the two white plugs attached to the 

top of the drive and nudge those aside. 

Leave the thin ribbon cables attached 

for now—if you’re careful, you can 

work around them. Gently pry up the 

drive from either the front or rear inner 

corner (away from the ’Book’s edge); the 

mounting bracket will come out with it, so 

note its orientation so you can replace it 

correctly. Remove the combo plug from 

the end of the drive, leaving the ribbon 

cable attached to the motherboard.

2 Remove the RAM
With the fi rst batch of screws out of the way, remove 

the RAM hatch door by pulling it out toward the vacant 

battery bay. Release the small levers on each side of the RAM 

module (which will spring up to about a 30-degree angle), pull 

the module straight out, and set it aside. Repeat this process 

if you fi nd another RAM chip lurking beneath the fi rst one. 

Now remove the two screws at the rear of the RAM hatch. 

(You’re taping all of these screws down as you go, right?)

3 Two More 
Screws

Flip your ’Book over to fi nd 

the two screws hiding in the 

battery bay, right under the 

trackpad. These screws tap 

into the lid-latch assembly, 

so be extra careful not to 

lose or confuse them. Do 

not forget to remove these 

before prying up the top of 

the ’Book!

ALSO >>> BLOG FROM YOUR CELL PHONE • MASTER iMOVIE FILTERS
▲

Look for the screws in 
the battery bay.

After releasing the levers, pull the RAM straight out.

Follow the arrows to fi nd the screws.

4 Take Off 
the Top

Remove the upper deck, 

keyboard and all, by fi rst gently 

prying up the rear (under the 

screen) with something fl at, and 

then working it up gradually 

with your fi ngers toward the 

front. When only the front edge 

is attached, gently wiggle the 

top piece to release it. (And be 

careful not to raise the rear edge 

too high off the base.) Once 

you’ve freed the front edge, 

angle the keyboard back, pivoting 

it on the rear edge, and unplug 

the keyboard connector.

As you gently pry your ’Book’s 
top off, mind the keyboard 
connector back there. 

The brown ribbon cable 
connects the hard drive to 
the motherboard.

6 Rubber Baby 
Hard-Drive Bumpers

Unscrew the four bumpers from your MacBook Pro’s 

original hard drive and install them on the new drive. 

Now comes the tricky part: Attach the ribbon-cable 

connector you removed from the original drive to the 

new drive and wedge it into place against the ’Book’s 

outer edge (look closely and you can see round 

recesses for the bumpers) while keeping the mounting bracket noted in step 

5 wedged against the drive’s other side. As you work, mind the Bluetooth 

wad and its associated wires, and make sure you tuck in all four bumpers 

on the hard drive snugly. When you get the drive in, replace the two screws 

from step 5. Now put everything back in the order you took it apart.  |<

The keyboard connector plug is so 
delicate that it has to be taped down to 
the motherboard—so be careful not to 
mangle the tape. If necessary, you can 
replace it with clear tape.  

▲ ▲ ▲ ▲

>>>Create>>>>>>
▲ ▲ ▲
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The Specs

802.11b Apple’s original AirPort introduced Wi-Fi to the 
masses. Operating in the 2.4GHz frequency, 802.11b is limited 
to theoretical speeds of 11Mbps and a relatively meager range 
of 150 feet.

802.11g The second wave of wireless, 802.11g boosts 
802.11b’s speed and range to 54Mbps and 300 feet, 
respectively, and provides backward compatibility with 802.11b 
devices (without the increased speed and range). Apple’s current 
AirPort devices—and most other Wi-Fi hardware—use 802.11g.

802.11n A few different versions of 802.11n are already on 
the table, dubbed “pre-n” and available from the likes of Belkin 
and Netgear. In fact, Belkin gave up on waiting for the offi cial 
spec and has debuted its N1 line of 802.11n hardware. 802.11n 
boasts speeds of up to 300Mbps, but only with specifi c .11n 
drivers, which aren’t available for the Mac. AirPort cards using 
.11b and .11g can connect to .11n networks, but only at their 
respective native speeds.

MIMO  Multiple Input, Multiple Output is all the rage—despite 
sounding like a bad porno fl ick. Where normal Wi-Fi sends data 
over one channel in the 2.4GHz frequency, MIMO splits the signal 
over two or more channels within the 2.4GHz band, increasing 
both speed and range. 802.11n is basically MIMO-fortifi ed .11g.

WDS  Extending a Wi-Fi network to cover your sprawling 
estate might require you to set up a Wireless Distribution 
System, which merges multiple access points (also known as 
base stations) into a single network covering more area than 
a lone router can. Such a setup requires compatible hardware 
and generally works best if all of the devices in the system come 
from the same manufacturer.

ENHANCED 802.11g (TURBO G, SUPER G, 
108G)  Most Wi-Fi vendors have adapted MIMO versions of 
their .11g gear to provide theoretical speeds of 108Mbps—twice 
.11g’s 54Mbps. But none of the double-g solutions work with 
Apple’s AirPort card; to use MIMO-g on a Mac, you need a 
specifi c Wi-Fi adapter and router and OrangeWare’s Wireless 
Driver for Mac ($15, www.orangeware.com). Check the 
OrangeWare Web site for device compatibility.

SECURITY MATTERS  Imagine your personal 
information fl ying through the air where any passing creep can 
harvest it by the handful. Wi-Fi certainly opens you up to this 
risk. That’s why we always suggest using security encryption. 
Your AirPort card supports all of the common wireless security 
standards, which include various fl avors of WEP and WPA. 
(LEAP falls under WEP, smartypants.) However, we’ve found that 
different vendors implement the standards differently, so, for 
example, if you can’t connect to a given router using WEP 40-bit 
hex, switching the security to WEP 128-bit ASCII might get you in.

802.11n isn’t yet an accepted 
standard, but Belkin’s N1 
Wireless Router ($149.99, www
.belkin.com) is a promising start.

Wireless networking, aka Wi-Fi, is arguably 
humankind’s best invention since the 

television. And much like the world of TV 
technology, the Wi-Fi landscape is littered with 
acronymic protocols, overlapping standards, 
and incompatible hardware. Here’s how to stoke 
your bloke (or your betty, or yourself) with home-
networking gear that works—with an existing 
network, with a Mac, and with the knowledge you 
glean from these pages.

Field Guide to  WIRELESS NETWORKING

Walkin’ in a Wi-Fi 
Wonderland
by Niko Coucouvanis
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Hardware 

WI-FI ROUTER A modern router is essentially a network in a box. It 
provides Ethernet ports to connect nonwireless Macs, a Wi-Fi transmitter for 
wireless connections, and all the networking protocols you need to keep your 
Macs connected with each other and the Internet—while keeping hackers out.

WI-FI ADAPTER Apple’s AirPort Extreme 
Card is by far the most common Wi-Fi adapter 
for Macs. Not only does the card come built in 
on most modern Macs, it’s nearly the only Wi-Fi 
adapter available with Mac-compatible drivers.

ACCESS POINT To extend your own network via WDS 
(Wireless Distribution System), or to connect (or bridge) a wireless 
network to a wired one, you want to connect an access point 
via either Ethernet or Wi-Fi. Unlike a simple signal repeater, an 
access point gets its own IP address from the main router so it can 
essentially create a new network and act as a conduit between this 
new network and the main network.

HI-GAIN, NO PAIN For the fastest, 
farthest-reaching network, we recommend Hawking 
Technologies’ Hi-Gain Wireless-108G MIMO Router with 
AMP Technology ($129, www.hawkingtech.com) and 
the matching Hi-Gain Mini Wirelesss-108G USB Adapter 
($49.99). The latter is one of the only Wi-Fi adapters 
(not made by Apple) that provides Mac drivers. You can 
also use your AirPort card with Hawking’s router—we 
did, and got better range than with an AirPort router, 
but note that you need the matching USB Wi-Fi adapter 
to get the full MIMO 108Mbps support.

The router’s three 
antennae work together 
to boost your speed 
and range.

ONE STEP BEYOND In the time-honored tradition of plug and play, one excellent way to 
get more out of your wireless network is to add an antenna or signal booster. MacWireless has plenty 
to choose from, including our favorite combo, the dangerous-looking (it’s freakin’ 5 feet tall!) 12dBi 
Omni Antenna ($149, www.macwireless.com) paired with the company’s 11g 15x AirPort Mini Booster 
($159.98), which is available with connectors to fi t Apple’s AirPort Extreme, as well as anything sporting 
either an RP-TNC or an RP-SMA antenna connector—which covers just about every router we’ve seen.

ONE STEP TOO FAR  What about 
those sexy little antennae people hook 
up to their G4 PowerBooks? Most of those 
connect directly to the AirPort card, which 
is buried deep in the ’Book’s bowels, 
meaning you have to eviscerate your laptop 
to install them. Last time we tried one, it 
cost our PowerBook a new SuperDrive and 
keyboard—more than $300—and barely 
boosted the ’Book’s range. 

P.S. DON’T FORGET THE POWERSQUID Network gear is notorious 
for using extra-bulky AC transformers (aka wall warts), which can block outlets left and 
right on a regular power strip. The solution is a smarter power strip, and we dig Flexity’s 
PowerSquid Surge3000 Calamari Edition ($79.95, www.powersquid.net). Besides 
its cool name and dangerous-looking design, the ’Squid can accommodate the most 
heinous AC adapter—plus, two of the outlets sport LEDs for easier use in the dark under 
your desk.

Crikey! If this antenna 
doesn’t give you 
enough Wi-Fi range, 
you’re beyond hope.

REPEATER A repeater is a combined Wi-Fi receiver/transmitter that 
can pick up a faint Wi-Fi signal and boost it. If your neighbor’s unsecured 
network is allllmost within working range of your desk or couch, for example, 
stick a repeater in your house where the signal is strongest, and avail 
yourself of some free Wi-Fi!

The PowerSquid 
is a sure sign of 
evolution.

Wi-Fi reaffi rms Niko Coucouvanis’s faith in humanity.

For a simple, short-
range Wi-Fi network, 
an AirPort Express 
($129, www.apple
.com) is all you need.

Small and wedge-shaped, 
the Belkin Wireless G 
Travel Router ($69.99, 
www.belkin.com) functions 
as an access point, 
repeater, or adapter.
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The Audioengine 5 speakers (pictured) not only 
have iPod connectivity, but also feature a rear AC 
outlet and an auxiliary jack, so you can connect 
Apple’s AirPort Express and remotely play your 
iTunes music. See the full review on page 62. 
Next month we’ll look at Canon’s HV10 high-
defi nition camcorder, Doghouse Electronics’ 
RoverTv portable media recorder and player, Alien 
Skin’s Blow Up plug-in for Photoshop, Native 
Instruments’ FM8 audio synthesizer, and more.

We’d spend our 
own hard-earned 
money on this 
product.
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You’ll be 
impressed.

You’ll be 
satisfied.

You’ll be 
disappointed.

You’ll be 
pissed off.

RATIN¬S

You’ll be 
blown away.

REVIEWS 45
better living through smarter shopping

Universal application 
that runs natively on 
both PowerPC and 
Intel Macs.
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The speed increases with the 
new MacBook Pro are impressive.

T his is something we’re just not used 
to. We only recently learned to cope 

with minor update after minor update 
of the PowerBook G4 notebooks. 
Then, at the beginning of 2006, the 
MacBook Pro came on the scene, and 
notebook users rejoiced—fi nally, here 
was a notebook with a long road of 
development ahead of it. Now we’re 
looking at the fi rst stop on that road: 
the switchover from the Core Duo to 
the Core 2 Duo processor. And our 
testing shows that there’s a lot to be 
excited about.

For this review, we looked at the 
midrange 15-inch MacBook Pro, which 
has a 2.33GHz Core 2 Duo processor 
and comes standard with 2GB of RAM. 
The notebook we tested came with a 
5,400-rpm 160GB hard drive instead of 
the 5,400-rpm 120GB hard drive that’s 
in the standard confi guration; the 160GB 

hard drive adds $100 to the $2,499 
base price. We compared the 2.33GHz 
MacBook Pro’s result to the model it 
replaces, the 15-inch Core Duo–based 
2.16GHz MacBook Pro.

The speed increases with the new 
MacBook Pro are impressive. The Core 2 
Duo MacBook Pro was 21 percent faster 
than the Core Duo MacBook Pro when 
creating a OneStep DVD from a movie 
in iDVD and when applying a Sepia 
Tone video effect in iMovie HD. When 
exporting a video in iMovie HD, the 
new MacBook Pro was a whopping 43 
percent faster. In our GarageBand Send-
to-iTunes test, the new MacBook Pro 
was only 3 percent faster. These results 
were taken with the new MacBook Pro at 
2GB of RAM and the old MacBook Pro at 
1GB. We also tested the new MacBook 
Pro at 1GB—you can’t buy the 2.33GHz 
MacBook Pro with 1GB of RAM, but we 
wanted to see how much of a difference 
RAM made. And as it turns out, our iLife 
’06 test results at 1GB were practically 
the same as our results at 2GB.

Does that mean the extra 1GB of RAM 
is wasted? Not when you consider the 
speed of non-Intel-native applications 
that must use Apple’s Rosetta, which 
performs translations of PowerPC-native 
software on the fl y so the MacBook’s 
Intel processor can do its work. For 
example, in our Adobe InDesign CS2 
PDF-export test, using 1GB of RAM in 
both MacBook Pros, the new MacBook 
Pro was 22 percent faster. When we 
boosted the RAM in the new MacBook 
Pro, the InDesign results at 2GB were 13 
percent faster than the 1GB results. In 
our Adobe Photoshop CS2 Actions test 
at 1GB, the new MacBook Pro was only 
2 percent faster than the old MacBook 
Pro. But at 2GB, the results with the new 
MacBook Pro were mind-boggling—a 67 
percent increase over the new MacBook 
Pro’s results at 1GB. More RAM is good.

The results in our Doom 3 video 
benchmark test were impressive as 
well. The new MacBook Pro was 31 
percent faster than the old MacBook 
Pro. However, before you decide that the 
new MacBook Pro would make a good 
gaming Mac, consider that we used an 
Intel-native version of Doom 3 for our 
test—non-Intel-native games will suffer 
under Rosetta.

We also tested battery life by 
watching a Lawrence of Arabia DVD 
(we never get tired of that movie). The 
new MacBook Pro was able to make 
it to the movie’s intermission, and 
the battery lasted two hours and 24 
minutes—seven minutes longer than the 
old MacBook Pro’s battery.

The bottom line. If you decided to 
pass on the fi rst-generation MacBook 
Pro and hold on to your PowerBook 
G4, don’t wait any longer—the $2,499 
15-inch MacBook Pro is an impressive 
notebook. There’s really no reason to 
putter along with that G4 notebook 
anymore, unless you’re the sentimental 
type.—Roman Loyola

15-inch 2.33GHz Core 2 
Duo MacBook Pro
SPEEDY NOTEBOOK MAC

COMPANY: Apple
CONTACT: 800-692-7753 or 
408-996-1010, www.apple.com
PRICE: $2,499 ($2,599 as tested)

SPECIFICATIONS: (as tested) 2.33GHz Intel 
Core 2 Duo, 2GB RAM, 256MB ATI Mobility 
Radeon X1600 card, 160GB SATA hard drive, 
AirPort Extreme, Bluetooth 2.0, Apple Remote

GOOD NEWS: Nice speed boost over previous 
generation. Improved Rosetta performance.
BAD NEWS: 3GB RAM limit.

Proof that switching to Intel 
was the right thing to do.



Wacom Graphire4
Have fun with your digital photos

Enhance photos with pen control
Quickly and easily edit your digital photos using the 
control of the Graphire pen and your included copy 
of Adobe® Photoshop® Elements 3. Selectively apply 
high-quality photographic enhancements using the 
included Nik Color Efex Pro™ 2 GE filter collection.

Draw and paint
Create original artwork with the natural feel of your 
Graphire pen and the amazing capabilities of the 
included copy of Corel®  Painter™ Essentials 2.

Jot notes, handwrite emails, and sign
Use your Graphire pen on a Mac to enjoy all the 
digital-inking capabilities of Apple® Inkwell®.

Patented pressure-sensitive pen
•  512 levels of pressure sensitivity for natural 

brush control
•  Patented cordless, battery-free technology for a 

natural feel and superior performance

Cordless, battery-free mouse
•  Patented cordless, battery-free, ball-free, and 

optics-free mouse with three programmable 
buttons and a scroll wheel

•  Alternating between the pen and the mouse 
reduces repetitive motion

Valuable software included
Includes Adobe Photoshop Elements 3, Corel Painter 
Essentials 2 for creating natural media art, Nik 
Color Efex Pro 2 GE for selectively applying photo 
enhancements, and more.

Visit
www.MacPhotoFun.com

Call
1.800.922.1247 

©2006 Wacom Technology Corporation. Wacom, Graphire, Intuos, and Cintiq are trademarks of Wacom Company Ltd. All rights reserved. 
All other trademarks are property of their respective owners. All prices are U.S. estimated street prices. 

Have fun with your photos! 

From $99

Cintiq®

Work directly on screen

Cintiq 21UX – $2499

For the serious photographer, 
designer, and artist

Intuos starts at $229

Intuos®
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Even with its quirks, the Picture 
Porter Elite can be useful.

At a mere 1 by 1 by 3 inches, the 
Picture Porter Elite is a portable 

media device that can store and display 
photos from a digital camera, play 
music (including FM radio), and show 
videos on either the device itself or a TV. 
It can do more than an iPod, but it’s not 
as elegant.

Transferring pictures from your 
camera is easy and relatively fast. 
Just select the Backup icon, snap in 
your camera’s memory card (it takes 
CompactFlash, SD, and Memory Stick; 
other formats require third-party 
adapters), and choose either Full 
Backup, which will back up everything 

on the card including data, audio, and 
video, or Photo Backup, which will hunt 
only for images. We transferred 512MB 
of photos from a SanDisk Ultra II CF 
card in two and a half minutes. Photo 
thumbnails can be scrolled eight-up or 
displayed full-screen—a bright 3.6-inch 

LCD allows wide-angle viewing. With 
the pics now on the Picture Porter Elite, 
you can clean your memory card in your 
camera and shoot more pics.

The Picture Porter Elite rotates photos 
quickly, and you can check image 
sharpness by zooming in. When you look 
at pictures, you can display limited EXIF 
information (exposure, ISO, resolution, 
date and time, and lens used) along 
with a histogram of each image; this 
information appears over the image 
you’re looking at. We were pleasantly 
surprised to fi nd that the device can 
also display RAW images from dozens 
of cameras, such as Canon’s 1D, 30D, 
300D, Rebel XT, and others; Nikon’s D80, 
D70, D1x, and others; and many Kodak, 
Fujifi lm, Olympus, and Minolta cameras 
(the Digital Foci Web site has a complete 
list of supported RAW formats). With the 
included cables and remote, viewing our 
photos on a TV screen and printing them 
out on any PictBridge-enabled printer 
was a no-brainer. 

The device’s rechargeable Li-Ion
battery provides four hours of 

continuous playback for stills 
and videos, and up to 12 hours 
when playing audio-only fi les: 
MP3, WMA, unprotected AAC, 
and WAV formats only—you 
can’t play any music purchased 
from the iTunes Store (you 
also can’t play any TV shows 
or movies purchased from the 
iTunes Store). Audio, though, 
is the Picture Porter Elite’s 

Achilles heel. The sound from 
the built-in speaker is so tinny you 

can fuggeddaboudit, and you might 
think about using better-sounding 
earbuds than the ones Digital Foci 
provides. Tuning in to FM radio stations 
was kludgy; the earphones have to be 
plugged in because their wires double 
as an antenna, but plugging in the 
earphones disables the speaker.

On the upside, the device plays 
videos quite well. Though it’s not 
compatible with QuickTime’s MOV 
format, it’s simpatico with MPEG-1, 
MPEG-4, Motion JPEG, and WMV. If your 
TV has a video-in jack, you can connect 
the Picture Porter Elite and play its 
videos on the TV. If your TV has a video-
out jack, the Picture Porter Elite can take 
that TV signal and record it. The problem 
was that the included audio/video 
cable for input to the Picture Porter 
Elite didn’t work; Digital Foci confi rmed 
that the RCA plugs on our cable weren’t 
functional. We had to spend $12 on 
phono-plug couplers to fi x the problem. 
What a hassle.

The bottom line. The Picture Porter 
Elite is a versatile little bugger, it’s 
simple to operate, and if you shoot a lot 
of images, it could very quickly pay for 
itself in memory cards you won’t have to 
buy. It won’t replace an iPod for music, 
but even with its quirks, the Picture 
Porter Elite can be useful.—Arthur Bleich

Picture Porter Elite
USEFUL DIGITAL-MEDIA STORAGE AND PICTURE VIEWER

COMPANY: Digital Foci
CONTACT: 310-763-9100, 
www.digitalfoci.com

PRICE: $399 (40GB), $469 (80GB)

REQUIREMENTS: Mac OS X, USB

GOOD NEWS: Transfers images from most memory 
cards. PictBridge printing.
BAD NEWS: Requires extra adapters to record TV 
shows. Mediocre sound. Can’t play FM through speaker. 

It’s easy to use, but it won’t replace your iPod.



Little Big Disk 320GB
FAST PORTABLE HARD DRIVE

L aCie’s Little Big Disk is yet another 
compact mobile hard drive. There are 

plenty of other mobile-friendly drives, 
but the Little Big Disk stands apart 
thanks to its massive storage capacity, 
blazing speed…and high price. 

Capacity-wise, the drive ships in sizes 
up to 320GB, which is twice the storage 
space of any other mobile drive you’ll 
fi nd these days, and which can hold up 
to 23 hours of DV video, six hours of 
DVCPRO HD video, or more than 20,000 
10-megapixel RAW pics. 

The drive stores all this data because 
its rugged aluminum case actually 
houses not one, but two small hard 
drives striped together into a hardware 
RAID 0. This RAID also delivers read and 
write speeds that are about 50 percent 
faster than standard mobile hard drives—
and sure enough, we were able to edit 

two streams of DVCPRO HD video off the 
Little Big Disk with no hitches. For best 
results, use the FireWire 800 interface.

The Little Big Disk draws its power 
from the FireWire 800, FireWire 400, 
or USB connection. That means that it 
doesn’t need a wall socket for power. 
That also means you don’t have to 
lug around a big, hefty black brick in 
addition to the drive. LaCie does include 
a power adapter (in case you’re using an 
underpowered USB hub, for example).

The two-drives-in-one 
approach does have a 
couple of drawbacks, 
however. For one, the Little 
Big Disk stands about 
twice as high as other 
mobile drives, and 

it weighs 1.4 pounds, so you’re more 
likely to notice it in your travel bag. 
Also, the drive puts an extra drain on 
your ’Book’s battery (it drained our 
PowerBook’s battery 45 minutes faster 
than a conventional mobile drive)—
although you won’t have to worry about 
battery drain if your ’Book is plugged 
into the wall.

LaCie also includes its SilverKeeper 
backup software. This basic utility lets 
you do scheduled backups, but it doesn’t 
have network support, unfortunately.

The bottom line. The Little Big Disk 
isn’t cheap, but if you need a heavy-duty 
hard drive for some mobile video editing, 
it’s your best bet.—Helmut Kobler

 LaCie
 503-844-4500, 

www.lacie.com

 $429.99 (320GB, tested), 
$429.99 (200GB), $299.99 (160GB)

 FireWire 800, 
FireWire 400, or USB

 Good speed and lots of storage in a small 
package. Bus-powered.

 Bigger and heavier than other mobile drives. 
Expensive.

You could buy 
two conventional 
500GB drives 
for less than 
the price of this 
320GB RAID 
array.
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The mind map was popularized 
in the 1960s as a more natural 

way to take notes. Constructed with 
a central idea or concept placed at 
the center, and branches that radiate 
clockwise from the center, mind maps 
are used for brainstorming, problem 
solving, scheduling, and countless 
other tasks. For this review, we looked 
at a pair of mind map applications: 
Mindjet’s MindManager 6 and NovaMind 
Development’s NovaMind 3.2.

Both products provide tutorials 
to get you started. We preferred 
MindManager’s animated tutorial, 
which quickly and effi ciently imparts 
the information you need to get 
started. NovaMind’s written tutorial 
is effective but more time-consuming. 
Both products lay out your maps as you 
build them—helpful for newcomers. 
Unfortunately, MindManager never 
relinquishes much control over your 

map. We appreciated NovaMind’s three 
layout modes, which let us choose the 
amount of fl exibility we wanted. Despite 
the different approaches to where we 
could place the branches of our maps, 
both products offer a wide range of 
options for formatting branch designs, 
fonts, and colors.

A mind map’s branches can be 
adorned with icons, pictures, notes, and 
links. Both applications include scores 
of images to use in your mind maps, but 
NovaMind’s offerings are more varied 
and engaging than MindManager’s 
repetitive and sometimes cryptic 
images. NovaMind displays text 
notes in a fl oating window, while the 
MindManager window has a notes pane 
that can be toggled. Choosing between 
the formats is a matter of taste, but 
MindManager gets our nod for displaying 
text notes in a tool tip whether or not the 
notes pane is displayed.

Mind maps aren’t nearly as compact 

as linear text. As you add multiple 
layers of branches, images, links, and 
groupings, your map can easily grow 
beyond the dimensions of your display. 
Both MindManager and NovaMind help 
you cope with bloat by allowing most 
layout elements to be toggled globally. 
When printing, for example, hiding 
hyperlinks is a useful option. Selectively 
hiding branch layers is also possible. 
NovaMind provides a detail slider while 
MindManager offers keyboard shortcuts. 
MindManager’s Filter feature is a nice 
touch that allows you to quickly hide 
everything but the selected elements.

Exporting is where NovaMind clearly 
outshines MindManager; we counted 17 
ways to get your map out of NovaMind. 
Keynote and PowerPoint export creates 
simple presentations with the whole 
map depicted on the fi rst slide, and a 
slide for each branch composed of plain 
text. It’s not something you’re going 
to present as-is, but the roughed-out 
framework is something to start with 
and—at the very least—spares you the 
fi nger cramps and tedium of a hundred 
copy-and-paste routines. While the 
Keynote export worked as we expected, 
PowerPoint export isn’t a traditional 
export at all. Rather than save a new 
fi le in PowerPoint format, NovaMind 
requires you to have PowerPoint running 
with a slide show document open at 
the time of export. It then controls 
PowerPoint using Visual Basic Scripting 
to create the new slides. Interestingly, 
another NovaMind export option is 
MindManager XML. MindManager, by 
contrast, isn’t as generous, offering 
four types of image export and three 
of text. More frustrating is reading the 
specifi cations for MindManager’s PC Pro 
version, in which PowerPoint, Word, and 
HTML export are touted. Argh.

While MindManager and NovaMind 

MindManager 6 and NovaMind 3.2
STIMULATING MIND-MAP SOFTWARE

MINDMANAGER 6
COMPANY: Mindjet
CONTACT: 877-646-3538, 
www.mindjet.com

PRICE: $229
REQUIREMENTS: Mac OS 10.4 
or later, 70MB disk space

GOOD NEWS: Comfortable user interface. Password 
protection. Animated tutorials.
BAD NEWS: Pricey. Anemic export options. 
Constraining layout choices.

MindManager’s interface works well, but 
its layout choices can be constraining.



NOVAMIND 3.2
NovaMind

www.nova-mind.com

 $99

Mac OS 10.3.9 or later, 

60MB disk space

 Myriad export choices. Helpful Branch Proposal System. 
Better bundled graphics.

 Pricey. Icon-driven interface can be confusing.

share the common purpose of creating 
mind maps, each has some unique 
features with no analogue in the other. 
MindManager allows maps to be 
password protected, and it can store 
authorship metadata. One handy feature 
is the callout, comic-strip-like speech 
bubbles attached to branches of your 
map. When you have a text note that’s 
too important to simply link to, callouts 
are an appealing way to put that text 
right on the map. MindManager is more 
Mac-like in its interface—you may not 
forget that you’re working in a product 
with deep PC roots, but Mindjet has 
made a genuine effort to make its app 
look and feel like Mac software.

NovaMind is not without its unique 
goodies. We could spend hours playing 
around with the Branch Proposal 
System. The BPS, as it’s called, is a 
tool to help stimulate new connections 

among your thoughts. Starting on any 
branch with text, clicking the Suggest 
Child Branch or Suggest Sibling Branch 
button opens a list of words related to 
the words on your branch. While it’s 
similar to a thesaurus, the BPS casts 
a wider net than just synonyms. We 
invoked the BPS from a branch titled 
Solve Problem and got some synonyms 
and antonyms, but we also got words 
like pyrogen. It’s hard to argue that a 
fever-inducing substance of bacterial 
origin is anything but a problem that 
needs solving.

The bottom line. On features alone 
it’s a tight race, but we prefer NovaMind 
for its fl exibility, superior export 
choices, and Branch Proposal System. 
NovaMind’s $99 price brightly contrasts 
Mind Manager’s $229 asking price. We 
can’t see paying more than twice as 
much money for something almost as 
good.—Stuart Gripman

NovaMind has great graphics, though its interface is confusing.



Battery 3
GROOVIN’ DRUM SAMPLER

Native Instruments
866-556-6487, 

www.native-instruments.com

 $229
Mac OS 10.4 or later, 

512MB RAM, 14GB disk space

 Extensive percussion-sample library. Deep editing and 
effects capabilities.

 Its lack of built-in rhythms or beats relegates it to the 
professional drumming crowd.

Battery 3 is a slick, potent sampler 
geared toward triggering drum 

sounds, and while it’s exceedingly 
capable and customizable, it’s not a 
drum machine for instant gratifi cation. 
To tame this beast, you’ll need some 
actual drumming chops.

Battery 3 takes a large array of 
sampled drum sounds and maps them 
onto a series of MIDI notes that are then 
played on an external controller such as 
the M-Audio Trigger Finger (
Mar/06, p50) or any MIDI keyboard. We 
also tested Battery in GarageBand (it’s 
loaded as an Audio Unit plug-in) and 
were able to use our Mac’s keyboard to 
tap out rhythms. Battery 3 can be used 
as a stand-alone app or with any Audio 
Units–compatible software.

Battery 3 has no built-in rhythm 
generation abilities along the lines of 
the instant gratifi cation provided by 
Steinberg’s glorious Groove Agent 2 
(  Sep/05, p47) or Glaresoft’s 
addictive iDrum (  Jan/05, 
p48), which are designed for unskilled 
drummers. You can load standard MIDI 
fi les into Battery 3, which then trigger the 
sounds and produce rockin’ grooves, but 
you’ll have to hunt those MIDI fi les down 
on the Web. Once they’re in, you can 
use various tricks to add roll, fl am, and 

other human touches, 
resulting in a looser, 
more organic feel.

The main interface 
is a single window 
with the Cell matrix 
at the top and modal 
editing panels at the 
bottom. The Cells 
(up to 128 per kit) 

are used to drag and drop individual 
sampled sounds to be triggered via 
MIDI, with Cells corresponding to 
specifi c MIDI notes. Battery 3 comes 
with more than 12GB of sampled 
percussion sounds, encompassing 
a wide range of musical genres and 
styles. These sounds are organized into 
preconfi gured kits; loaded into Battery, 
a kit’s individual instruments appear 
in their corresponding Cells. Clicking a 
Cell triggers the sound, and when you 
use an external controller, the velocity 
of a played note creates a crossfade 
between multiple sounds mapped onto 
a single MIDI note. Play a note on the 
Trigger Finger softly, for example, and 
a soft snare-drum tap is the resulting 
sound; hit the pad with more force, and a 
secondary, rougher snare snap is played 
instead. You can create your own velocity 
and kit maps with any of the included 
drum samples, or import your own 
sampled sounds. Battery also makes a 
great soundboard for podcasting, perfect 
for triggering sound effects in real time 
while you’re recording shows.

The bottom line. Pro musicians looking 
for a one-stop drum sampler will be well 
served by Battery 3, as long as they have 
the skills needed for composing cohesive 
and convincing percussion patterns. 
If tabletop fi nger drumming is not your 
strong suit, you might want to consider 
a simpler software drum machine with 
built-in beats.—David Biedny

Battery 3 has ample 
editing tools for looping 
selections of sound fi les.
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FontVista 3.5
SERVICEABLE FONT-CATALOG SOFTWARE

FontVista 3.5 is a font manager that 
serves as an interface for fonts 

installed on your Mac. With version 3.5, 
FontVista now supports TrueType (Mac 
and Windows versions), PostScript Type 
1, Multiple Master fonts, OpenType, and 
Apple DataFork fonts.

FontVista’s interface makes it easy 
to print samples of your font collection. 
All you have to do is select the font, 
decide on one of three layouts, and 
then click the Print Page button. 
Printing a font sample using Apple’s 
Font Book (which comes with Mac OS 
X; it’s in your Applications folder) isn’t 
so simple—you actually have to use 
AppleScript to print the sample. (The 
script to print a font sample out of Font 
Book is in /Applications/AppleScript/

Example Scripts/Font 
Book/Create Font 
Sample.) FontVista’s 
hiccup when printing a 
sample is that if a font 
is missing, FontVista 
prints unsightly black 
rectangles instead.

Unlike Apple’s 
Font Book, FontVista 
doesn’t provide instant onscreen 
previews of your fonts; you must use 
FontVista’s Layout Preview to see a 
font onscreen.

We’d like to have the ability to preview 
smaller lists of checked fonts, rather 
than the whole library. It would also be 
good to be able to double-click a single 
font to view it. These options would be a 

more effi cient way to work, especially for 
designers with a thousand or more fonts. 
And FontVista isn’t as comprehensive 
as Morrison SoftDesign’s FontDoctor 
($69.99), which has features for weeding 
out corrupt fonts.

The bottom line. FontVista is a good, 
basic font-catalog application.
—James Ellerbeck and Roman Loyola

COMPANY: Morrison SoftDesign
CONTACT: 
www.morrisonsoftdesign.com

PRICE: $19.99
REQUIREMENTS: Mac OS X

GOOD NEWS: Good software interface. Easy controls. Quick 
access to font print samples.
BAD NEWS: No double-click font opening. No previews of 
single fonts.

It does its job reasonably well, but there’s room for improvement.

Bravo SE Disc Publisher
EASY-BAKE OPTICAL-DISC PUBLISHER

Our fi rst thought upon encountering 
Primera’s Bravo SE was “We should 

get the band back together.” The Bravo 
burns and then prints labels on up to 
20 optical discs in a run, completely 
unattended—or while you stare 
hypnotized as its robotic arm shuttles 
discs from stack to tray to print bed to 
output bin.

Disc burning and printing is a 
notoriously time-consuming task—
especially in bulk—so Bravo’s automated 
workfl ow (discfl ow?) will save you loads 
of time. The Bravo met its claimed 15-
discs-per-hour output on our sample 
disc, which contained 600MB of data 
and about 50 percent ink coverage.

The bundled Discribe mastering 
software walks you through the process 

of duplicating an existing 
disc or building a new audio 
or data disc; formats include 
VideoCD, CD Extra, ISO 9660, 
and DVD Video/Audio, but for a 
true interactive DVD, you need 
to use an authoring app such 
as iDVD.

The only glitch is that you have to 
design your art independently in a 
graphics app and then specify the image 
fi le in the print dialog. Fortunately, Bravo 
provides templates on the included CD 
for common disc sizes. Another concern 
is the cost of printable media: Primera’s 
printable CD-Rs cost from $.50 to $.80 
(DVDs start at $.90) each—we used the 
top-shelf TuffCoat with WaterShield CD-R 
discs and were rewarded with accurate, 

glossy prints that didn’t turn into a 
mess of bleeding color in the rain (or Dr. 
Pepper spill).

The bottom line. You either need a 
device like this or you don’t. But if you 
do, the Bravo SE is as affordable as it 
gets, and its image quality will make 
you look like a rock star—and that’s 
really what it’s all about, hmm?
—Niko Coucouvanis

COMPANY: Primera
CONTACT: 800-797-2772, 
www.primera.com

PRICE: $1,495
REQUIREMENTS: Mac OS 10.2 
or later, USB

GOOD NEWS: Burns and prints 20 discs unattended. Handy 
templates included.
BAD NEWS: Device and blank media are expensive. Design 
software not included.

The Bravo SE is a whole cottage industry 
in a box.



The only difference between the 
Intuos3 4x6 and the Intuos3 6x11 

( Apr/06, p49) is their sizes—
the Intuos3 4x6 is smaller (duh). It’s just as comfortable 
and accurate as the bigger tablet. So why take up precious 
magazine space for this product? Read on—but if all you 
need to know is whether the Intuos3 4x6 is a great tablet, 
the answer is yes, so skip ahead to the next review.

If you’re using a MacBook or a 15-inch MacBook Pro, the 
larger Intuos3 6x11 may be too big. Sound trivial? Not if 
you’re a graphic designer who demands precision. Controlling 
access to a smaller screen is easier with a smaller tablet.

The bottom line. Like its big brother, this is one great tablet 
for Mac addicts—and Mac designers.—Roman Loyola

Intuos3 4x6
WIDESCREEN-
SUITABLE TABLET

Wacom
800-922-9348, 

www.wacom.com

 The right size for smaller 
widescreen displays.

 Expensive.

 $229.95
Mac OS 10.2.8 or later, USB

A better fi t for smaller 
widescreen displays.

If you’re having trouble drawing 
attention to your iPod-clad 

self, you need Blinkit, a light-
emitting device that connects to 
your iPod’s dock.

Connect one of the included blue, clear 
(which fl ashes white light), green, red, or 
yellow Blinkits to your iPod’s dock, and then 
press the Blinkit’s button to activate one of seven fl ash modes. 
A slider switch directs the light out the sides or the bottom of the 
Blinkit. It’s powered by your iPod’s battery, so it will have a slight 
effect on battery life. Also, it may not fi t your case-clad iPod, or if 
you’re using an iPod armband that blocks the dock.

The bottom line. Blinkit is a useful device for anyone who wants 
(or needs) to be seen.—Michelle Victoria

There’s also a red 
light for iPodders 
named Roxanne.

Blinkit
FLASHY iPOD LIGHT

Intuitive Devices

www.blinkitnow.com

 Bright light. Comes with five colors.
 Pricey. Check your case or armband 

for dock clearance.

 $29.95
iPod with dock
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Bigger may not always be better, 
but in the case of Canon’s 

imagePROGRAF iPF5000 inkjet printer, 
bigger will get you beautiful images 
and the fl exibility of output that you 
can’t achieve with most inkjet printers 
available today.

The iPF5000 is a beast of a printer, 
weighing 108 pounds and taking up 
about a 30-by-40-inch chunk of desk 
space. The iPF5000 uses 12 inks to create 
prints up to 17 by 22 inches. The inkset 
includes four black inks (photo black, 
matte black, gray, and photo gray), as 
well as the usual photo-inkset found 
in many photo-realistic printers—in 
this case, red, green, blue, yellow, 
cyan, photo cyan, magenta, and photo 
magenta. The inks come in 130-milliliter 
size only, priced around $65 each—pretty 
expensive, and Canon wouldn’t give us 
any specifi cs on how long we should 
expect each cartridge to last.

Along with the expanded inkset, you’ll 
fi nd an amazing selection of media to 
print on—about 50 at last count. Media 
range from canvas to archival-quality fi ne-
art papers to vinyl and backlit fi lms. Some 
of these media types are available in roll 
form up to 17 inches wide (a roll feeder is 

imagePROGRAF 
iPF5000
COLOSSAL WIDE-FORMAT PRINTER

a $289 option), as well as in cut sheets.
You can get gorgeous prints from 

the iPF5000, but the beautiful images 
come with a high price tag. The iPF5000 
is not the printer for the novice or the 
dilettante, but if you demand pro-level 
quality for large media formats, you’ll 
revel in the clarity and realism of the 
iPF5000’s prints. The iPF5000 uses 
pigment-based inks, which tend to be 
more moisture resistant than dye-based 
inks, and offer more resistance to fading.

There is a hidden cost: Calibrating 
your display and the iPF5000 is key 
to successful color reproduction. The 
iPF5000 doesn’t necessarily present you 
with the color you see on your monitor 
unless you spend time adjusting that 
color with a calibration device from a 
company such as ColorVision (www 
.colorvision.com) or X-Rite (www.xrite 
.com). It’s not a deal-breaker, but it is a 
consideration. 

The bottom line. Though it’s an 
expensive proposition (both its up-front 
price and long-term consumable costs), 
the iPF5000 is a solid (literally and 
fi guratively) large-format printer.
—Rick Oldano

Canon
800-652-2666, www.canon.com

 $1,945
Mac OS 9.1 or later or Mac OS X, 

USB or Ethernet network

 Beautiful images are your reward.

 Gigantic footprint. Expensive.

Big printing requires a big (and we 
mean big) printer.



HP
800-752-0900, 

www.hp.com

 $349.99
 Mac OS 10.3.9 

or later, USB

 Feature rich. Impressive digital 
zoom. Nice LCD. Good image quality.

 Antishake doesn’t work well. 
Many features are found on the cheaper R927.

The 10-megapixel Photosmart R967 supplants the 8-
megapixel Photosmart R927 at the top of HP’s point-and-

shoot line. It adds an antishake mode and 10x digital zoom. 
The updates look good on paper, but we don’t think they’re 
signifi cant enough to choose the R967 over the now-cheaper 
R927 ($299.99). 

The R967 has a lot of the core features that make the R927 
such a good thing. There’s the big, bright, and beautiful 3-inch 
LCD. Framing shots is easy, and the screen remains viewable 
even under strong daylight. The R927’s intuitive controls found
their way onto the R967.

And just like the R927, the R967 produces great-looking 
images. Colors are vivid and accurate, and overall sharpness 
is excellent, with noise noticeable only in photos taken in low 
light. The R967’s adaptive lighting technology helps bring out 
details in high-contrast photos—we found that the best results 
came when it was set to low, while using the high setting would 
sometimes wash out details.

In an attempt to rid photos of motion blur during low-light 
situations, the R967 adds a new antishake mode. It works by 
digitally “pushing the fi lm” (underexposing the image and 
then overdeveloping it). The technology needs more tuning; 
in our tests, antishake didn’t eliminate or even minimize blur 
signifi cantly, but did add tons of noise to our photos.

Surprisingly, the new digital zoom works like a charm. Image 
quality was impressive in pics we took with the digital zoom 
totally maxed out.

The bottom line. It’s hard to recommend the R967 over the 
R927 when the R927 is now a good value. If you need the extra 
megapixels and more successful digital zoom, go for the R967. 
Otherwise, the R927 remains your best bet.—Gil Loyola

Photosmart R967
CAPABLE POINT-AND-SHOOT CAMERA

More megapixels 
don’t always add up 
to a better camera.
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Silver Portable 80GB Dual
REPLETE EXTERNAL HARD DRIVE

The Silver Portable 80GB Dual is a 
cleanly designed portable hard drive 

that has everything you need from a 
compact drive. Its aluminum enclosure 
is minimalist—barely larger than the 2.5-
inch 80GB laptop hard disk it sheathes. 
The drive is almost silent and is powered 
via the USB or FireWire port.

Iomega packages the drive with 
both FireWire and USB cables. Yay! 
The USB cable also features a second 
USB connector to provide extra 
power for the drive, because on some 
laptops and with some USB cards, the 
power provided by one USB port isn’t 
suffi cient. The drive also features a 
5V DC power connector, but no power 
supply—you’ll need to supply your own. 
But since the drive works fi ne powered 

by the USB or FireWire port, this isn’t 
a necessity.

We tested the device using both 
FireWire and USB 2.0 and discovered 
its performance to be typical of most 
portable hard drives. Via USB 2.0, 

read performance averaged 14.88MB 
per second, with write speeds slightly 
higher at 15.62MB per second. As usual, 
FireWire performance was faster, with 
typical read speeds of 27.9MB per 
second and write speeds of 27.8MB per 
second. The aluminum case keeps the 
drive cool, too—it didn’t feel warm to 
the touch.

Instructions for use are provided, 
along with a CD that has a full copy of 
Retrospect Express 6.1. Retrospect 
may not be the most intuitive backup 
software around, but it is reliable, and 
its inclusion is a welcome addition to 
this reasonably priced portable drive.

The bottom line. The Silver Portable 
80GB Dual has a lot to offer in its little 
package.—Ed Haynes

COMPANY: Iomega
CONTACT: 888-516-8467, 
www.iomega.com

PRICE: $149.95
REQUIREMENTS: FireWire 400 
or USB

GOOD NEWS: Compact design. Runs cool and quiet.
BAD NEWS: Pricey. USB 2.0 should be faster.

Portable, slim-line storage that’s truly 
clutter free.

i-Station3
PORTABLE iPOD SPEAKER STAND

Road warriors like to travel light, 
which makes the iPod a nice travel 

buddy. Now your iPod can have a travel 
buddy of its own: the i-Station3 portable 
iPod speaker stand.

Measuring 4.41 by 6.3 by 1.18 inches, 
the i-Station3 easily fi ts into carry-on 
luggage or a backpack—though you’ll 
either need to make a little bit of room 
for the power adapter or use four AA 
batteries. The iPod dock folds out, and 
when you attach your iPod (you get 
several iPod adapters for a good fi t), the 
i-Station3 charges it when the power 
adapter is used. The i-Station3 has a 
rear USB dock so you can connect it to 
your Mac for some syncing goodness. 
There’s also an auxiliary-in jack for other 
audio devices.

The i-Station3’s audio 
quality matches that of 
similarly priced portable 
radios or CD players—not 
particularly warm sounding, 
with some bass distortion and 
weak highs, but acceptable. 
But when you’re traveling, the 
i-Station3 makes hotel living 
a lot more comfortable. On 
a road trip, we successfully 
occupied a couple of toddlers 
with the i-Station3—we played 
a few videos on the iPod while 
the audio went through the 
i-Station3 so both kids could 
hear (some of us can’t afford to install 
elaborate DVD theaters in an SUV). A 
remote control isn’t included, however.

The bottom line. The i-Station3’s 
small size and battery capability make 
it a nice traveling companion for your 
trusty iPod.—Roman Loyola

COMPANY: Logic 3
CONTACT: 
www.spectravideo.com

PRICE: $59.99
REQUIREMENTS: Dockable iPod

GOOD NEWS: Decent audio quality. Small and portable. 
Can use batteries.
BAD NEWS: Weak bass and high-end sounds. No remote 
control.

About as big as 
a day planner.
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Avid Xpress Pro uses the same interface as Avid’s other editors, so if you know one Avid, you know them all.

Avid Xpress Pro 5.5 is a high-powered 
video editor brought to you by the 

company that put the digital into digital 
video editing. Not only does Xpress 
offer a long list of pro-level features, 
but it also sports fi le compatibility with 
higher-end Avid gear found in edit bays 
around the world. But Xpress still has 
some annoying quirks; namely, its Mac 
support has been pretty iffy lately, and 

it also costs nearly $400 more than 
Apple’s Final Cut Studio ($1,299, www
.apple.com), which has more features.

Xpress’s core features have been 
in place for years—things such as 
fl exible trimming tools, advanced color 
correction, real-time video and audio 
effects, multicamera editing, media 
consolidation, and a highly customizable 
interface. Version 5.5’s most important 

improvement is that it can capture, edit, 
and export HDV and DVCPRO HD video 
as well. If you’ve jumped on the HD 
bandwagon, chances are that Xpress 
will work with that stunning footage 
you’ve shot. Plus, if you add Avid’s Mojo 
hardware to the mix ($1,695 to $2,495), 
you can also work with uncompressed 
SD video. Xpress still doesn’t support 
uncompressed HD, which is something 

that Apple’s Final Cut Pro handles right 
out of the box.

Xpress does have something that 
Final Cut users will envy, however: 
the ability to combine different media 
formats on a single timeline without 
having to render them fi rst. Nowadays, 
a project’s footage can come from 
different cameras shooting in different 
formats, and Xpress’s ability to 

seamlessly mix them all together is a 
time-saver. Another feature we dig is 
Xpress’s built-in motion stabilizer, which 
can remove (or at least minimize) camera 
shake. Effects packages such as Adobe 
After Effects or Apple’s Shake can do the 
same thing, but being able to do it right 
in your video editor saves time. 

Arguably, Xpress’s biggest advantage 
is that it’s compatible with all of the 
high-end Avid workstations in the world 
(and there are lots of them, since Avid 
is considered the gold standard in fi lm 
and TV production). You can do the vast 

majority of your work using Xpress, 
and then take your project to a rental 
suite and fi nish it up on a high-end 
Avid box. For example, suppose you 
shot your project in uncompressed 
HD, but you copied it to DV video 
tapes and edited those tapes on your 
Xpress-equipped PowerBook. (Why not 
a MacBook Pro? More on that later.) 
Once your edit is done, you could take 

Avid Xpress Pro 5.5
POWERFUL VIDEO-PRODUCTION SOFTWARE SUITE

COMPANY: Avid Technology
CONTACT: 800-949-2843, 
www.avid.com
PRICE: $1,695, $49.95 upgrade

REQUIREMENTS: G4 or faster, Mac 
OS 10.4.6 or later, QuickTime 7.1 or 
later, 1GB of RAM, 128MB of video 
RAM, 40GB disk space

GOOD NEWS: Full of pro features. Works with popular 
HD formats. Compatible with higher-end Avid systems.
BAD NEWS: Historically iffy Mac support. So-so 
companion apps. No Universal binaries. Pricey.
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Advertisement

iPod Showcase

Interested in advertising?

To advertise in the iPod 
Showcase, contact: 

Larry Presser
646-723-5459
lpresser@maclife.com

Stacey Levy
650-238-2319
stacey@maclife.com

World’s Smallest Charger

Lighten your load. 
RadTech’s ACpower is the world’s 
smallest and most powerful 
iPod and USB charging solution. 
Slightly larger than a match box, 
the ACpower features fl ip-out 
AC blades that rotate a full 270 
degrees, allowing it to fi t into any 
AC receptacle, even on crowded 
power strips.

www.radtech.us/acpower

Audioengine 5
PRIMO iPOD SPEAKERS

The lucrative iPod-speaker market 
has plenty of choices, but many units 

sacrifi ce quality for size. This leaves an 
opening for the Audioengine 5 speaker 
system to fi ll a niche that’s likely to start 
growing this very minute. 

The Audioengine 5 has two distinct 
speakers, eschewing the one-piece 
construction that’s popular with iPod 
speaker sets. The benefi t is a far more 
explicit stereo sound image—something 
even Apple’s iPod Hi-Fi struggles with. 
The downside is that you have some 
speaker wire to deal with. No biggie.  

The Audioengine 5 charges your iPod 
while it’s plugged in, but there’s no actual 
dock—the Audioengine 5’s powered USB 
port does not allow for data transfer. 
Plugging in an iPod shuffl e will require the 

adjacent audio input. 
On the back of the 

left speaker you’ll 
fi nd another audio 
input and an auxiliary 
AC outlet, which is 
perfect for plugging in 
an AirPort Express to 
stream your iTunes library wirelessly to 
the speakers. Brilliant. Of course, you 
can plug just about anything in there—at 
the very least, the outlet helps clean up 
that tangled web of wire. 

All of these inputs don’t mean much 
if the actual sound quality is subpar, so 
we’re glad to say that these are among 
the best-sounding iPod speakers we’ve 
ever heard. Crisp, clean audio emanates 
from the boxes, and the huge sound 

never betrays their bookshelf size (each 
speaker is 10 by 7 by 7.75 inches). Even 
the bass levels are quite prominent 
without the use of an external subwoofer, 
though the speakers do favor the highs 
at louder volumes. 

The bottom line. If sound quality is 
your main concern, you can’t go wrong 
with the Audioengine 5.—Kaiser Hwang

COMPANY: Audioengine
CONTACT: 877-853-4447, 
www.audioengineusa.com

PRICE: $349
REQUIREMENTS: Device with 
audio out

GOOD NEWS: Fantastic sound and build quality. No receiver 
needed. Well-thought-out design.
BAD NEWS: Costs more than other speaker systems. No 
digital input, dock, or remote.

Also available in black.

Banshee Listening Station

The only 5.0 surround system in 
a single listening station.
Shatter the perceived limitations of 
audio for your iPod with a massive 
50 watts of peak output power. The 
Banshee’s patented technology 
produces ultracrisp midranges with 
deep and powerful bass. Available 
at RadioShack, select Circuit City 
stores, Discovery Channel Stores, 
and Chicago-area Abt Electronics 
locations.
www.BansheeAudio.com
312-474-6108



62 REVIEWS
better living through smarter shopping 63REVIEWS

August 2006   May 2006   6363Advertisement

iPod Showcase

Elite Audio Gear

6i Isolator Earphones deliver 
detail, balance, comfort, 
and value. 
The in-ear secure fi t reduces 
background noise so you can listen 
at safe levels. Hear crisp, clear 
music inside your head. Great for 
travel and working out. Available 
online or at Apple Stores and other 
retail locations worldwide.
www.etymotic.com

The B-Flex’s sound is richer than the sound from the speakers 
on a MacBook Pro or PowerBook G5, and the volume is a 

couple of notches louder. But since you can’t play 
both the built-in speakers and the B-Flex at the 

same time, you’re basically replacing the ’Book 
speakers. The B-Flex is better than the Mac mini’s 

built-in speaker—but that doesn’t take much. 
You can spend the same $40 on an affordable set of 

powered speakers that use the Mac’s audio-out jack 
(though you’ll need a power outlet). The B-Flex extends 

about seven inches from your Mac’s USB 
plug—and the device was loosey-goosey 
in each USB jack we plugged it in to. 

The bottom line. If you want to 
minimize your carry load, you’ll like 
the B-Flex.—Roman Loyola

B-Flex
USB-POWERED SPEAKER

COMPANY: JLab Audio
CONTACT: 520-393-8414, 
www.jlabaudio.com

GOOD NEWS: Small enough to tote around.
BAD NEWS: Expensive. Loose USB connection. 
Short gooseneck.

PRICE: $39.95
REQUIREMENTS: USB

The B-Flex actually proves 
that the ’Book speakers 
aren’t so bad after all.

Looking like some dark-ages medical instrument, the 
iSuperCharger is an iPod charger that can use four 

different power sources: a 12-volt car socket, 
your Mac’s powered USB jack, a power outlet, 
or a 9-volt battery. Plug the iSuperCharger’s 
dock connector into your iPod and you’ll 
soon see the charging battery icon on your 
’Pod’s screen. Easy enough.

You can still use your iPod 
while it’s charging, but the 
iSuperCharger’s dock cable is 
short, so you’re closely tethered 
if the device is plugged in. Also, the 
USB cable is almost too short—on a crowded 
USB hub, it’s hard to fi nd a fi t.

The bottom line. It’s a handy device.—Roman Loyola

iSuperCharger
HANDY iPOD CHARGER

COMPANY: Van Hauser
CONTACT: 800-990-1900, 
www.ipodsupercharger.com

GOOD NEWS: Can use four different power 
sources to charge your iPod.
BAD NEWS: Pricey. Short USB and 
dock cable.

PRICE: $39.95
REQUIREMENTS: iPod

Despite its 
Frankenstein-like 
design, it works well.

iPod Mounting Solutions

Taking your music with you 
is even easier with ProClip!
ProClip mounting solutions are 
the best way to mount your iPod in 
your vehicle. The mount clips on in 
seconds without interior damage. 
For details on ProClip mounting 
solutions for your iPod as well 
as your other devices, visit:
www.proclipusa.com
800-296-3212

PodSwap

Owning an iPod can be more 
affordable than you think. 
Purchase new or “PodSwap 
Certifi ed” used iPods.  
Get cash or instant credit for your 
used or broken iPod. We guarantee 
everything we sell and pay fair 
prices for used or broken iPods. 
One stop does it all. Let PodSwap 
expand your options. 

www.PodSwap.com



65
because you play as hard as you workGAMES

GAME NEWS

Roll Your Own
Stop complaining about the 

sorry state of Mac games. Put 
your money where your mouth is—
and make your own. You can start 
with the new Torque Game Engine 
1.5, which now has rewritten 
Mac-platform code to make 
development a lot easier and more 
Mac-like. It’s even multithreaded 
so it can take advantage of 
multiprocessor power.—RL

Created using the 
Torque Game Engine.DEV/PUB: GarageGames, www.garagegames.com 

AVAILABLE: Now  ■  PRICE: $150 (indie license), $750 (commercial license)
TORQUE GAME 
ENGINE 1.5

Were you hoping to unwrap 
that brand-new World of 

Warcraft expansion pack, The 
Burning Crusade, during the 
holidays? Were you counting on 
The Burning Crusade to provide 
you solace from holiday family 
get-togethers, during which 
your mom loves to retell that 
embarrassing story about how you 
didn’t stop breastfeeding until you 
were 6 and your tipsy dad blabs 
about how you could’ve been the 
next Heisman winner if it weren’t 
for the fact that you have your 
mother’s hips? Well, here’s the 
bad news: Blizzard says that The 
Burning Crusade will slip a few 
weeks so some bugs can be fi xed, 
and so it won’t be available until 
January—that means it’ll miss the 
holiday shopping season. That 
also means you level-60 types get 
to spin your wheels for a few more 
weeks. The good news? Heisman 
Trophy winners don’t necessarily 
make it in the NFL. Just ask Gino 
Torretta.—Roman Loyola
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COMING SOON

The Crusade Will 
Have to Wait

“Sorry we’re late. But 
we’re fashionably late.”DEV/PUB: Blizzard, www.worldofwarcraft.com  

AVAILABLE: January 2007  ■  PRICE: $39.99  
WORLD OF WARCRAFT: 
THE BURNING CRUSADE
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Yes, the new game from 
Vanbrio is indeed called 
Bone. Go ahead, get your 
giggles out (heh, heh; you 
said bone…). Done? OK. In 
this adventure game, you play 
Fone Bone, and you’re lost. 
It’s up to you to fi gure out how 
to fi nd your cousins, Phoney 
Bone and Smiley Bone. This 
game is based on Jeff Smith’s 
graphic novel Bone: Out from 
Boneville, and the game does 
a great job of capturing the 
novel’s artistic stylings.—RL

GAME NEWS

Be a Bone 
Head

I see London, 
I see France…

DEV/PUB: Vanbrio Entertainment, www.vanbrio.com  
AVAILABLE: Now  ■  PRICE: $12.99  

BONE ACT ONE: OUT 
FROM BONEVILLE

The Sims 2: Open 
for Business
YET ANOTHER SIMS 
2 EXPANSION PACK

Many people dream of breaking 
free from The Man by starting a 

business. Sims are no different. The 
Open for Business expansion pack gives 
your Sims the ability to start and run a 
business. It’s satisfying, but after a while, 
Open for Business is all about work. And 
eventually, work just isn’t much fun.

To start a business, you buy a 
community lot or set up shop in your 
home. You can create any number of 
businesses; you’re only limited by the 
types of objects available to you. We 
bought a small space and turned it into 
a fl ower shop and espresso bar. Besides 
selling prefab plants, we invested in a 
fl ower stand that allowed our Sims to 
create and sell their own arrangements 
while improving their skills in that craft.

Using the special business tools in 
the upper-right corner of the screen, you 

purchase merchandise 
and set prices for your 
wares. You spend most 
of your time working the 
store, developing skills. 

As your business grows 
popular with customers, 
you earn stars; once 
you gather enough, your 
business rank goes up 
and you get perks such as 
cheaper wholesale prices 
or an automatic boost in 
reputation.

Compared to other Sims expansion 
packs, Open for Business is trickier to 
master. It took a while to fi gure out how 
to open or close the shop (you need to 
buy a sign) and how to set prices.

The bottom line. While the fi rst few 
sales are exciting, the thrill goes away. 
Open for Business may add an extra 
dimension to your Sims’ existence—but 
it’s about work, not fun.—Cathy Lu

SO-SO
RATED

GOOD NEWS: Lets you build a business from the 
ground up. Finally, you can follow your Sims to work.
BAD NEWS: A little more complex than other Sims 
games. Dull.

COMPANY: Aspyr
CONTACT: 512-708-8100, www.aspyr.com
PRICE: $34.99
REQUIREMENTS: 1.2GHz or faster processor, Mac 
OS 10.3.9 or later, 256MB RAM, 2GB disk space

We’re fi nally realizing our Eliza Doolittle dreams by opening a 
modest fl ower shop.



www.macsoftgames.com
Blood
Violence
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P laying like a combination of Robotron and Asteriod, 
Arcadrome is full of fast-paced, shoot-em-up action. Your 

goal is to pick up energy crystals before the aliens get their 
grubby alien paws/hands/tentacles/whatever-appendages-
they-have on you. With 100 levels, Arcadrome is sure to fi ll 
the hours on those cold winter nights.—RL

GAME NEWS

Blast and Run
GAME NEWS

Get Tanked
Every now and then, we get a hankerin’ for Combat on 

the Atari 2600—but we’re too lazy to haul our 2600 out 
of storage. Fortunately, there’s Mountain Tanks, a 3D game 
that’s much, much cooler than Combat. You command a tank 
with a ton of weapons and you have to defend your city. You 
get to play with all sorts of things that go boom, such as 
ballistic rockets and grenades. Eat your heart out, Lieutenant 
T.M. Landry.—RL

ON THE
DISC

Arcadrome 1.0

DEV/PUB: PolyEx, www.polyex.com  
AVAILABLE: Now  ■  PRICE: $17.95  

ARCADROME

The chase is on.

DEV/PUB: Battery Acid Games, www.batteryacid.org
AVAILABLE: Now  ■  PRICE: $14  

MOUNTAIN 
TANKS 

Weapon of mass 
destruction.
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because inquiring minds have the right to be inspired

on the right side of the iTunes status 
window thingy?
That’s actually a snapback icon—
recognize it from Safari’s URL bar? Click 
it to bring the currently playing song to 
the top of your browser window. Bonus: 
Apple calls that status window thingy 
the iTunes Display Area.

SNAP BACK, JACK
What’s up with the little curvy arrow 

BATTERY CHECK
Is there some widget or app that will 
show the status of the batteries in my 
keyboard and mouse?
It depends on who made your keyboard 
and mouse. Apple’s wireless mouse and 
keyboard both report their respective 
battery levels back to your Mac, for your 

perusal via System Preferences > 
Mouse & Keyboard > Bluetooth. If you 
use non-Apple wireless devices, check 
for battery levels under the Wireless 
setting in your device’s driver software 
or System Preferences pane.

Our mouse’s batteries are in good shape, 
but we lost our wireless keyboard.

ZOOMY
Isn’t there a quick and easy way to 
zoom in on my Mac’s screen?
We just discovered one, and it’s a real 
hoot—though it works only in Mac OS 
10.4.8 or later. Hold the Control key 
while diddling your Mighty Mouse’s 
scrollball or twiddling the scrollwheel of 
a so-equipped mouse.

FADES MAKING YOU CROSS?
In iTunes, songs start playing before 
the present song is done playing. 
Why does this happen—and, more 
important, how can I fix it?
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http://c-command.com/spamsieve/) 
and add Thingy to the list of known 
spammers whose email is blocked 
automatically.

You can easily educate Mail’s junk 
mail fi lter.

STYLIN’ TYPE
Since TypeStyler isn’t out—yet?—for 
Mac OS X, are there any alternative 
text-twisting applications besides 
Microsoft Office WordArt? It’s gotta 
be cheap—I can’t afford professional 
graphics apps.
Yup, we got tired of waiting for 
TypeStyler, so we’ve turned elsewhere 
for our text tweaking. Adobe Photoshop 
Elements ($79.99, www.adobe.com) 
has rudimentary effects like Flag, Fish, 
Arch, and Wave, each configurable 
via sliders. To use an effect, select 
Elements’ type tool, type some text, 
then select Layer > Type > Warp Text and 
knock yourself out—the text remains 
editable until you simplify (or rasterize) 
the layer (Layer > Simplify Layer). If you’d 
rather try something with way more 
options and way less stability, we just 
discovered ChocoFlop (free alpha, on 
the Disc or www.chocoflop.com), which 

lets you apply Mac OS X’s Core Image 
filters directly to your text. If you go this 
route, be warned: ChocoFlop is a work 
in progress, currently at alpha status—
meaning it’s not even beta yet—so it 
might crash at any time, taking with it 
the stylized logo that 
you just blew the last 
two hours tweaking.

ON THE
DISC

ChocoFlop 0.50

Photoshop Elements can make Garamond 
look at least fairly grand.

PNG PONG
When using good ol’ Command-Shift-3 
(or 4) under Panther, the screenshots 
came out as PDF fi les. Now with Tiger 
they’re in PNG format? Is there a way to 
change which format to use?
Nope, you’re at Apple’s mercy there. 
You can dance around this restriction, 
though. If you want to capture TIFF files, 
use Grab (/Applications/Utilities). If you 
want to pick a different format, try this 
trick: Press Command-Control-Shift-3 
(or 4)—adding the Control key makes the 
screenshot go directly to your Clipboard. 
Now open Preview (/Applications/
Preview) and select File > New From 
Clipboard to deposit your screenshot in 
a blank document, which you can save 

AUTODESPAMIFICATION
I keep getting mail from a spammer 
called Thingy, and I would like to block 
it. How do I block all messages from his 
specific address in Apple’s Mail app?
We don’t want to know about this Thingy 
of whom you speak, but we can help 
you avoid his mail. In Mail, highlight 
a message from Thingy and select 
Message > Bounce from the menubar, 
which will send him a bounce-back 
message claiming that your address is 
invalid—which will hopefully convince 
Mr. Thingy to take you off of his list. 
Another way to dodge specifi c emailers 
is to add them by name to your junk 
fi lter. Open Mail > Preferences > Junk 
Mail, click Advanced, and use the plus-
sign icon to add a condition. Use the 
pull-down menus to confi gure the new 
condition as in our screenshot, and the 
mail might keep coming, but you’ll never 
see it unless you dig into your Junk box. 
If you use Microsoft Entourage, make 
similar adjustments under Tools > Junk 
Email Protection and Tools > Rules. Yet 
another solution is to buy a third-party 
spaminator such as SpamSieve ($25, 
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HOW TO 71No whining—
anyone 
can do this!

It’ll take some 
effort, but you 
can do it.

This stuff’s 
for the pros.

DIFFICULTY
RATINGS 

iDVD 
iDVD 6’s Media Browser is cool, but I want to 
use pictures that aren’t in my iPhoto Library. 
Can I get them into the Media Browser 
without importing them into iPhoto?
You sure can. Assemble the photos you 
want in a folder and drag the folder into 

Submit tech questions or 
helpful tips directly 

via email (askus@macaddict.com) or c/o 
MacAddict, 4000 Shoreline Ct., Ste. 400, 
South San Francisco, CA 94080.

iDVD’s Media Browser—
just make sure you click 
the Photos tab fi rst.

SAVE
When I save a document, 

some apps let me save anywhere on 
the Mac, but some only offer a list of 
places to save it. What gives?
That’s what the spiffy little blue arrow 

next to the Save 
As text fi eld is for; 
click it to morph 
the truncated Save 
dialog into fully 

navigable Finder-esque window. 

Oh, that’s a feature! Although Apple 
calls it Crossfade Playback, we call it 
annoying. Turn it off via iTunes > 
Preferences > Playback.

DOCK, DOCK, GOOSE
Who says that you can’t rock multiple 

docks on your screen 
at the same time? 
We did, in Ask Us, 
Nov/06, p60. But we 
were wrong, so very, 
very wrong. Wily readers 

reminded us of two options: A-Dock X 
($10, on the Disc or http://jerome
.foucher.free.fr/ADockX/ADockX.html) 
and DockFun ($19.95, on the Disc or 

www.donelleschi
.com/dockfun). We 
stand corrected and 
duly spanked.

in Preview’s default format (that pesky 
PNG again) or whatever format you 
prefer in the Save As dialog.

QUICKTIME, EXTRA QUICK
Is there a way to make my QuickTime 
movies play automatically when 
someone opens their iWeb page?
Surprisingly, no—at least not a push-
button way. If you’re willing to dig into 
some code, however, you can force 
iWeb movies to automatically play when 
the page loads. Roll up your sleeves 
and launch a text editor—if you use 

TextEdit (/Applications), launch the 
app fi rst, select TextEdit > Preferences, 
and click the Open & Save tab. Put a 
checkmark in the box labeled Ignore 
Rich Text Commands In HTML Files. Close 
the preferences dialog and open your 
iWeb site folder, either on your iDisk or 
in the Finder, depending on where you 
publish your site. For each movie page, 
iWeb creates a folder called Movie_fi les, 
inside of which you’ll fi nd a fi le called 
Movie.js (if you changed the default 
page title, use it here in place of Movie). 
Open the fi le in your text editor, press 

Command-F (or Edit > Find > Find), and 
type autoplay into the search box. 
When you fi nd it, change the associated 
value from the default False to True. 
iWeb uses two types of encoding, so fi nd 

Find your movie’s fi les under Movie if you 
didn’t rename them in iWeb.

autoplay again and change the value 
to True. Note that you’ll have to repeat 
this process every time you publish the 
site and overwrite your changes, so it’s 
worth your while to use TextWrangler 
(free, www.barebones.com), which has 
a simple batch Find & Replace feature.

Yakkity-yak, don’t crossfade my playback!

ON THE
DISC

A-Dock X 1.4.6
DockFun 4.7

UNIX UNIVERSITY

Niko Coucouvanis never met a Mac he couldn’t 
beat into submission, yet he knows that one 
will someday replace him.

UNIX MAIL
Can’t I use Unix for something useful 
that I actually do, such as sending 
email?
Sure, but this is the realm of true 
geeks. How geeky, you ask? Well, 
when you send email via Unix and 
your Mac’s Terminal, you drop the e 
and just call it mail. Deep in its Unixy 
heart, Mac OS X contains a full mail 
system that operates independently of 
your standard ISP-account email that 
you access through a client app such 
as Eudora, Thunderbird, Entourage, 
Apple Mail, and so on. You can use the 
built-in Unix Mail to send and receive 
messages with users on your local 
network or out over the Internet. 

To fi re off an email, type mail 
recipient@isp.com (substituting your 
recipient’s real email address) and 
press Return. When prompted, enter 

a subject for your message, press 
Return, and then get on with your 
message—there’s no prompt for you to 
type the message body. When you’re 
done typing, press Return to enter a 
line break, then type a single period (.) 

and press Return to end 
and send the message. 
If you try this trick at 
work or school, note 
that mailing to people 
who aren’t on your 
local network might not 
work, depending on 
how the recipient’s mail 
host interacts with your 
company (or school) 
network’s machine-
naming protocols. 

To see mail that 
you’ve received, or 

otherwise tinker with your secret mail 
system, type mail and press Return; then 
type a question mark (?) and press Return 
for some help. Type q and press Return to 
exit mail. As always, type man mail and 
press Return to access the manual pages.

Your Mac’s internal mail system is as no-frills as it gets.



Make Ubuntu’s partition at least 10GB. 

If you’re not 
equipped for a 
700MB download 
and disc burning, 
order Ubuntu on 
CD—it’s free.

There are as many versions of Linux as there are grains 
of sand in Waikiki (OK, well, almost as many). But for 

the kindest Linux initiation, we recommend Ubuntu Linux (free, 
www.ubuntu.com), which comes preconfi gured with a host of 
handy helper apps that make it easier than you’d expect to get 
your Mac running under Penguin power. Download Ubuntu—it’s 
nearly 700MB, so you might prefer ordering it on CD, which is 
also free. Note that you’ll need to burn the downloaded fi le 
onto a CD anyway, so if you aren’t equipped to burn discs, order 
the prefab installer (just click the Ship It Free link on the main 
Ubuntu page and follow the instructions). If you’re downloading, 
select Mac (PowerPC) Desktop CD and download the disk image 
to your Mac’s Desktop. Load a blank CD into your Mac’s optical 
drive, launch OS X’s Disk Utility (/Applications/Utilities), click the 
Ubuntu disk image in the left pane, and then choose Burn from 
the menu at the top of the screen.

To get the most out of Ubuntu on your Mac, you’ll want 
to maintain an OS X partition on the side (if for no other 

reason than that The Sims don’t exist in Linuxland). Be sure you’ve 
backed up all of your data before attempting this step, or it’ll all 
be lost permanently. Boot your Mac from your original Mac OS X 
install disc (insert the disc, shut down, and then hold down the C 
key while starting up) and then run Disk Utility (select Utilities > 
Disk Utility from the menubar). In Disk Utility, select your hard 
drive in the left pane and then click the Partition tab in the right 
pane. You’ll want to create three partitions, the fi rst of which 
should be a Free Space partition of at least 10GB in size, which 
is where you’ll install Ubuntu. The second is a Mac OS Extended 
partition for Mac OS X, which you should name Macintosh HD, 
and the third should be a Free Space partition of about 500MB 
or so in size, which you’ll use as a Linux swap partition later on. 
Click Partition to seal the deal, quit Disk Utility, and proceed with 
installing Mac OS X on your Macintosh HD partition.
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Run Ubuntu Linux on 
Your PowerBook
by Robert Strohmeyer

W
e love OS X, but our inner renegade wants to try out Linux, 
the infamous rebel OS. Here’s your hands-on guide to 
getting Ubuntu Linux up and running on your PowerBook. We 
chose a mature Mac for two reasons: First, Ubuntu’s system 

requirements are plenty gentle, and second, we don’t advise subjecting 
your main Mac to this type of identity crisis.

On that note, be sure to back up all of your data before beginning any of 
these steps, or you’ll be sure to lose it forever. Really. We’re not kidding.

1 Get Linux

PowerBook or other PowerPC-based Mac

Ubuntu 6.06 or later (free, www.ubuntu.com)

WHAT YOU NEED

Prep Your Partitions2

Note: This tutorial shows you how to install 
Ubuntu Linux on a PowerPC-based Mac using 
the PPC version of Ubuntu. If you have an Intel 

Mac, the instructions will be much the same, but you 
have to use the i386 version of Ubuntu.



Each fully interactive course includes:

• CD-ROM curriculum with 20 activities in each of 92 lessons
• Previews, comprehensive exercises and testing for each lesson
• Automated tutorials that “learn” where you need extra help
• Curriculum Text and 45-page User’s Guide

“...your program is the absolute best, bar none. I am 
shocked at how quickly I learn.”                    - Michael Murphy
                      Texas, USA 

“Stupendous...the juxtaposition of text, sound and picture 
was masterful. The quality of both sound and graphics 
was first rate.”   - The Boston Globe

Step-by-step immersion instruction in all key language skills:

Listening - Rosetta Stone uses native speakers and 
everyday language to develop your understanding of 
the spoken language naturally and easily.

Reading - Text exercises develop your reading 
skills by linking written language to real-life objects, 
actions and ideas.

Speaking - Speech-recognition feature records, 
diagrams and compares your voice to the native 
speaker’s, grading your pronunciation.

Writing - Practice writing the language you are 
learning with the program to guide you. Simply 
write what you hear, then the program carefully 
checks your work and lets you correct any mistakes.

Award-winning software successfully used by 
U.S. State Department diplomats, Fortune 500®

executives and millions of people worldwide.

The fastest way to learn 
a language. Guaranteed.
The fastest way to learn 
a language. Guaranteed.
Finally, a different approach that has millions of people talking. Using the 

award-winning Dynamic Immersion™ method, our interactive software teaches

without translation, memorization or grammar drills. Combining thousands 

of real-life images and the voices of native speakers in a step-by-step immersion

process, our programs successfully replicate the experience of learning your 

first language. Guaranteed to teach faster and easier than any other language

product or your money back. No questions asked.

Finally, a different approach that has millions of people talking. Using the 

award-winning Dynamic Immersion™ method, our interactive software teaches

without translation, memorization or grammar drills. Combining thousands 

of real-life images and the voices of native speakers in a step-by-step immersion

process, our programs successfully replicate the experience of learning your 

first language. Guaranteed to teach faster and easier than any other language

product or your money back. No questions asked.

French
German
Chinese
English

(US or UK)

Italian
Tagalog
Russian
Spanish

(Latin America or Spain)

Japanese
Vietnamese
Indonesian
Portuguese

Farsi
Thai

Korean
Hindi

Greek
Arabic

Hebrew
Turkish

Danish
Swahili
Polish
Welsh

Dutch
Latin

Pashto
Swedish

™™

Call today or buy online for a 10% discount.
RosettaStone.com/mas017

1-800-399-6162
Use promotional code mas017 when ordering.

SAVE
10%

 Personal Edition. Solutions for organizations also available.

Level 1 Program
Regularly $195.00

Your Price 

$175.50     

Level 2 Program
Regularly $225.00

Your Price 

$202.50     

Level 1 & 2
Regularly $329.00

Your Price 

$296.10

 BEST VALUE!



Once your Mac OS X partition is ready, it’s time to install 
Ubuntu; pop the Ubuntu CD into your drive and restart 

your Mac while holding down the C key. You’ll be greeted by 
a black splash screen with the Ubuntu logo and a few startup 
options. Next, select Start Or Install Ubuntu, and Linux will boot 
into Live CD mode, which lets you run and install the OS from 
the CD. After it starts up, you’ll see a big ol’ Install icon sitting 
on the desktop. Click that to get going.

Follow along through the install screens until you get to the 
Select A Disk screen. Here, select Manually Edit Partition Table 
and click Forward. The Prepare Partitions screen will show you 
the available partitions on your drive, and the following screen 
will let you assign specifi c uses to those partitions. Use the 
drop-down menus to designate your smaller (500MB) partition 
Swap and your larger Free Space partition your Linux root 
(identifi ed as a forward slash: /) and make sure both have a 
checkmark under Reformat. Then click Forward to complete the 

installation. After Linux is installed, your Mac will automatically 
reboot, and you’ll be presented with a little boot menu in the 
upper-right corner of your screen. By default, Linux will load 
unless you type either X for Mac OS X or C for CD-ROM.

Installing Linux doesn’t get any easier than this.
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As editor-in-chief of Windows Vista: The Offi cial Magazine, Robert 
Strohmeyer denies any involvement in the writing of this article.

By far the biggest hassle you’re likely to face in loading 
Ubuntu onto a PowerBook is the lack of AirPort drivers 

in Linux. The trouble here is that Broadcom, the company that 
makes Apple’s AirPort cards, hasn’t made its source code 
available for Linux developers, so they’ve had to create a 
sneaky workaround. In fact, this workaround is one of the main 
reasons we had you install Mac OS X before installing Linux. This 
is an easy hack, but it takes a little effort. To do it, follow the 
instructions in the Ubuntu forums at http://ubuntuforums.org/
showthread.php?t=142727 with one exception: Get the driver 
directly from your Mac OS X partition rather than downloading it 

from the obsolete ghostcorp.net address listed (you’ll get an error 
if you try it their way). Open your Ubuntu Terminal (Applications > 
Accessories > Terminal), type in the commands from that 
forum thread, delete the line that reads wget http://www
.ghostcorp.net/AppleAirPort2, and enter the following in 
its place: cp $OSXROOT/System/Library/Extensions/
AppleAirPort2.kext/Contents/MacOS/AppleAirPort2 . 
Note that the command contains one blank space at the 
beginning, after cp, and one more right before the period at the 
end—that copies the fi le into your current working directory. The 
rest of the instructions in the forum thread work as described.

This command hijacks a copy of Mac OS X’s AirPort driver for Ubuntu to use.

With Ubuntu Linux installed and your AirPort wireless 
connection working, your PowerBook is ready to 

roll. Ubuntu comes preloaded with a whole bunch of useful 
apps, including a full-blown offi ce productivity suite called 
OpenOffi ce, a robust e-mail and contact/calendar program 
called Evolution, and the popular Firefox Web browser. 
Photoshop fi ends will get a kick out of the totally free GIMP 
image editor, which supports a massive array of plug-ins that 
make it a worthy contender to its not-nearly-free Adobe rival.

You can add more apps to your Linux system by running 
Add/Remove Applications (click Add/Remove at the bottom 
of the Applications menu) and surfi ng through the huge 
selection of free software. Pick some you like, and Ubuntu will 

download and install them for you in moments. You can pick 
from a whopping list of apps, utilities, games, and more.

What’s your pleasure? Ubuntu hooks you up with an endless 
selection of free software.

4 Enable AirPort

5 Get to Work (or Play)

Installation Station3

Linux has a well-earned reputation for complexity, and 
while Ubuntu does a good job of overcoming most of 

Linux’s geeky tech hurdles, it’s far from problem-free. To get 
quick answers from others who have traveled this path before, 
visit the Ubuntu forums at www.ubuntuforums.org.

Make Swap what? Find all the help you need at the Ubuntu forums.

6 Get Help



No more scrounging through Safari’s 
history when you accidentally close 
a window. 

Unfill Your AutoFill1 Command-Tab, Not Command-Q!2

Tab Ya Later3
Veg Out While Surfing4
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IdleWeb is like autopilot for the 
Internet.

We’ve fought with Safari’s AutoFill enough that we 
fi nally tracked down a way to manage the sucker. The 

benefi ts include no more errant fi ll-ins when Safari thinks it 
knows what we’re thinking, snappier Safari performance, and 
possibly tighter security. Open Safari > Preferences, select the 
AutoFill tab, and click the Edit box next to Other Forms. See all 
the sites listed there? Select and remove the ones that give you 
trouble, or click Remove All to start fresh. Click Done to return 
to the main AutoFill pane, then remove the checkmark from the 
Other Forms box to nip AutoFill in the bud, and make sure the 
box labeled User Names And Passwords isn’t checked.

You know not to use AutoFill for your user names and passwords.

Ever hit Command-Q and quit Safari when you intended 
to close a window (Command-W) or switch applications 

(Command-Tab)? Install Forget Me Not (free, on the Disc or 
http://math.uchicago.edu/~fowler/Software.html), and when 
you relaunch Safari, it’ll reload the inadvertently closed pages 
and tabs. Bonus: Forget Me Not also adds an Unclose Window 
command to Safari’s File menu so you can reopen a window 
after you accidentally close it. Forget Me Not is a SIMBL plug-
in, so you have to fi rst install SIMBL (Smart InputManager 
Bundle Loader—it’s a safe way to hack features like this into 

applications). A SIMBL installer and 
full instructions are included in the 
Forget Me Not package.

Tabbed browsing (Safari > Preferences > Tabs) rocks, 
loading new windows into the current window’s Tab Bar, 

from where you can instantly view any of the Tab-opened pages. 
You can press Command-T (or select File > New Tab) to add a 
new blank tab so you can type a page’s URL into the URL fi eld, 
but the cool kids use Safari Enhancer, which adds tons of handy 
tricks, including a cache deactivator, history options, and a New 
Tab button. Install and launch Safari Enhancer (free, on the Disc 
or www.celestialfrontiers.com), select System-Wide Settings, 
and check the box labeled Add New Tab Button To Safari 
Toolbar. Then launch Safari, select View > Customize Address 

Bar, and drag 
the New Tab 
icon into the 
Toolbar.

Add Tabs from the Toolbar.

Web surfi ng isn’t what you’d call an extreme activity, 
but all that scrolling and clicking—where’s Kiosk mode 

when we need it? IdleWeb turns the Web into the TV-style 
passive entertainment we crave. Grab the app off this month’s 
Disc (free, www.edot-studios.com); it’s an OS X Screen Saver 
Module, so double-click it and follow the onscreen prompts 
to install it for all users or only yourself. If the installer doesn’t 
deposit you in System Preferences > Desktop & Screen Saver, 
go there and select the Screen Saver tab. Then select IdleWeb 

from the list and click Options, 
where you can set page-scrolling 
behavior, activate Kiosk mode, 
and drag in sites from your 
Bookmarks list, or right from 
Safari’s URL bar into IdleWeb’s 
Bookmarks list. 

Mac OS 10.4 or later ($129, www.apple.com)

Safari 2.0 or later (free, www. apple.com)

WHAT YOU NEED

Choosing a Web browser is almost as big a deal as 
choosing the Mac OS over Windows—only Apple’s 
Safari browser isn’t as obviously superior to other 

browsers as Mac OS X is to Windows. Here, then, are some 
tricks and add-ons to make Safari sing.
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Soup Up Safari
by Niko Coucouvanis
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Forget Me Not 2.0, Safari 
Enhancer 3.3.1, IdleWeb 2.0
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Mac OS 10.3 or later 
($129, www.apple.com)

Firefox 1.5 or later
(free, www.mozilla.com)

Firefox extensions 
(free, https://addons.mozilla.com)

WHAT YOU NEED

Light a Fire under Firefox
by Niko Coucouvanis

The other major Mac Web browser, Firefox, has some unique 
tricks up its sleeve: extensions, which add missing features. 

Unlike standard browser plug-ins, extensions also provide 

confi guration for your specifi c needs; thousands of extensions 
are available free at https://addons.mozilla.com. Here we’ll show 
you some of our favorites and how to manage and tweak them.

WataCrackaz Auto SMS

StumbleUpon 2.86
Google Calendar QuickAdd 1.5.6

Caution: 
StumbleUpon 
may be habit 
forming, 
which may get 
you fi red.

Admit it. Sometimes you get bored at work—really 
bored, to the point that you can’t even think of 
a fun Web site to waste a few minutes at while 
your brain recharges. StumbleUpon compiles 
and categorizes well-reviewed sites so you can 
procrastinate more effi ciently, and it’s fully 
interactive so you can add your two cents via 
the thumbs-up and -down toolbar icons, or leave 
comments for other StumbleUpon users.

Google Calendar Notifier 2.5
We didn’t think we needed appointment 
reminders right in our Web browser, but 
after a week we’re hooked and can’t live 
without them.

As if you’d forget happy hour.

Niko Coucouvanis still considers Web browsers the scourge 
of the earth.

NoScript 1.1.4.5
Scripts on the Web are like people: Some are 
good, some are evil—and you can’t always tell at 
face value. So Firefox’s wholesale enabling and 
disabling of Java and JavaScript (Firefox > 
Preferences > Web Features) isn’t so handy. 
NoScript lets you decide on a site-by-site basis 
which scripts to run and which to disable. 

NoScript lets 
you decide 
on the fl y 
which scripts 
are OK.

You can send SMS text messages 
from Firefox’s Toolbar with the help 
of WataCrackaz. We’re not sure how to 
pronounce it (or if we want to know), but 
this slick extension lets you select a U.S. 
or foreign carrier, type in the telephone 
number, and bang off a text message. We know, using all 10 
fi ngers is technically bad chatiquette, but nobody has to know.

We wouldn’t use it 
to call 911, but this 
is slick.

Here’s a shortcut to add calendar entries quickly without having 
to open a Google Calendar page—but you do have to be logged 
into your Google account. Once you’ve installed the extension, 
just select Tools > Google Calendar Quick Add or press Control-; 
(semicolon) to summon the Quick Add box.

Fill up your 
Google 
Calendar 
from 
anywhere 
on the Web.

1

1. Many extensions bring their own Toolbar and 
park it up here.  2. Some just steal a corner of the 
Status Bar.  3. Some, like Google Calendar Quick 
Add, stay out of your way until summoned via a 
keyboard shortcut or the Tools menu. 
4. Control-click in the Toolbar to show or hide 
specifi c extensions. 5. Choose Tools > Extensions 
for the handy Extensions Manager.

2

5

3

4
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NewTek®

LightWave 3D 9.....................$195

Sibelius®

Sibelius 4.................................$239
Auralia 2.1.................................$89

MakeMusic®

Finale 2007.............................$239
PrintMusic 2006.......................$59

Adobe®

Acrobat Pro 8............Save 69%
Photoshop CS 2.........Save 52%
Dreamweaver 8.........Save 53%
Studio 8 ....................Save 71%

FileMaker®

FileMaker Pro 8.5 ...............$149

Corel®

Painter IX.5...........................$95
CorelDRAW Graphics Suite X3 ...$95

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices 
are ONLY for the academic community and are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

Adobe®

Creative Suite 2
Save! 67%
Order Today!
Design with the Best!

Quark®

QuarkXPress 7
Save! $560
Only!  $189.95

Make Amazing Projects!

Wacom®

Intuos3 6x11”
Save! $50
Only!  $319.95

Create Digital Artwork!

Alias®

Maya 8 Unlimited
Save! 85%
Only!  $359.95

Become a 3D Animator!

Give us a call anytime!  1-800-294-4035

Hey Parents!
“You you are eligible to

buy for your students at
home or away at school.”

M-Audio®

Ableton Live 5 ....................$249
Pro Tools 7 M-Powered ......$149
Keystation 49e Keyboard......$99

Microsoft®

Office 2004 Student/Teacher ....$139

Canopus®

ADVC-300 ..........................$429
ADVC-55 ............................$169
ProCoder 2 .........................$249



Visit us today.
www.fatcow.com/maclife

This Year’s Resolution:
Become a FatCow!

Original FatCow Web Hosting Plan
- 15 GB of Disk Space for Your Files
- 150 GB of Monthly Data Transfer
- 1500 E-Mail Accounts
- Online Store
- SiteDelux Site Builder
-- CGI, PHP
- Web Statistics

MiniMoo E-Mail Plan
- 1 Mailbox
- E-Mail Auto Responders
- E-Mail Forwarding
- 1 Page Web Site

$5
a year

All plans include friendly toll-free support
and a 30-day money-back guarantee.

$99
a year

Call us Today!
1.866.544.9343
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avoid costly service ..............
.

  do-it-yourself Powerbook, iBook, & iPod parts..........

free online FixIt Guides.....

......6-month warranty on most products.

Mac + iPod Parts & Upgrades

Thousands of parts and accessories for your Mac + iPod

We’ve got your back.
� Fast, advanced, proprietary techniques.
� All operating systems; Mac, Windows, OS/2,

Netware and UNIX.
� All storage devices including SAN, RAID 

and NAS systems.
� Instantly retrieve recovered data 

with DataExpress™.
� Recommended and certified by all 

hard drive manufacturers.
� Government Contracts
� Featured on MacAddict,MacWorld, 

CNN, BBC and others.

MacAddict 3.5˝ X 2.3˝

“We Can Save It!”

7 great reasons to choose DriveSavers:
DATA RECOVERY: 800-440-1904

©2006 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949  INTL: 415-382-2000  
Visit DriveSavers at www.drivesavers.com

“Restoring Data 
and Peace of Mind 

Since 1985”

Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 
lpresser@macaddict.com

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?
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Note: Prices are subject to change. 
Check our website for the most up-to-date info. Quantities limited to stock on hand. School P.O.’s welcome.

800-462-2160

.COM

We’ve got ’em!

WWW.
We’ve got all the memory solutions you need for:
Mac Pro • MacBook Pro • Power Mac • PowerBook iMac

• iBook • eMac • Mac Mini
Samsung memory available!

2gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro $349
1gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro 159
2gb 5300-667 for MacBookPro/Intel Macs 499
1gb 5300-667 for MacBookPro/Intel Macs 94
1gb 4200-533 for Dual Core G5 89
1gb 3200-400 for Dual Processor G5 92
1gb 2700-333 for PowerBook G4/iBook G4 109
* FB = Fully Buffered

You need ’em?

800-462-2160

®

since
1994

MacSolutions.comMacSolutions.com
800•873•3726800•873•3726
11933 Wilshire Boulevard, West LA, CA 90025 
Phone: (310) 914-3200  Fax: (310) 966-4433

WE BUY
USED MACS!

WE BUY
USED MACS!

We SELL New Memory, Drives and Accessories.

Select items available @ Apple stores
and Apple online or axio-usa.com

Hardpacks iPodcases

Macbookcases Softpacks

For a limited time, please visit axio-usa.com and receive free 
FedEx ground shipping with promotional code AOMA07

Axio sectional-MacAddict.qxd  11/14/06  4:08 PM  Page 1

Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?

Contact Larry Presser 
(646) 723 5459 
lpresser@macaddict.com

Contact Larry Presser 
(646) 723 5459 

lpresser@macaddict.com

Interested in advertising in the 
iPod Showcase?
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of the Internet and came 
across a banner ad for Mr. T’s 
new reality TV series. Being 
interested, I clicked on it. 
Firefox chose that moment 
to “suddenly quit.” My report 
to Apple consisted of the 
following: “I had just loaded 
Mr. T’s TV show Web site and 
Firefox quit. Go fi gure, huh?” 
I wonder what they’ll make of 
that.—Sean
We pity the browser that 
can’t handle the T! If your 
browser is back on the A-
Team, check out www.tvland
.com/originals/ipitythefool.
—Max

MIGHTIER THAN 
WE THOUGHT
I cannot fault your overall 
evaluation of the wireless 
Mighty Mouse (
Oct/06, p47); however, it 
might discourage people 
from even trying it—it 
received a fi ve-star rating 
from me. I have arthritis in 
my thumbs, and I have found 
the Mighty Mouse to be the 
most comfortable mouse 
I’ve ever used, as I’m able 
to control it without having 

SHARP TIPS, 
SHARP READERS
Your magazine stands out 
from the competition with 
the sense of fun and humor 
that is found in every issue. 
Also, you must be psychic 
with your software secrets 
“For Creatives” in the 
Nov/06 issue (“From the 
Minds of MacAddict,” p21)! 
Right when I was working 
on perfecting some images 
of a lighthouse that I want 
to submit to iStockphoto, I 
read your tips on Photoshop 
sharpening that made every 
other sharpening technique 
obsolete! I now have 
beautiful lighthouse images 
that I couldn’t possibly have 
achieved without such a 
timely tip from you guys!
—Charlie Thiel
Always happy to help! 
May your newly sharpened 
lighthouse lift your 
contributions above the fog of 
cruddier stock images.—Max

SHH, STARTUP
Your advice on how to 
silence the startup sound 
is worth the entire price of 

my MacAddict subscription.  
As soon as I installed 
StartupSound.PrefPane and 
heard my newly modulated 
startup chime, I knew life 
had changed for the better: 
No longer would I be waking 
my husband in the middle 
of the night if I suddenly 
needed my Mac. Bonus: Now 
I can ease into the morning 
gently, instead of being jolted 
hyperalert by that deafening 
major chord. A big, big thank 
you for a small (?) fi x!
—Anne Milton
Hey, if Macs can sleep, 
so should husbands. 
(Bonus: Extra credit for your 
MacAddict-esque use of 
“Bonus.”)—Max

OH, SOFTEN UP
I really enjoyed “From the 
Minds of MacAddict” article 
(Nov/06, p21), especially 
the “For Creatives” section 
by Mark. But (you knew a 
knock was coming…) taping a 
piece of paper over the fl ash 
of a camera will not produce 
a softer light. The only way 
to “soften” the light is to 
increase the size of the light 
source. The paper will reduce 
the output, which may appear 
as a softer light because 
you’re not blowing out the 

highlights, but you’ll have 
the same hard shadows.
—Marc Parsons
Excellent point; thanks 
for sharing. But as the 
Zen riddle asks, if a light 
appears softer, but no one 
is around to see it, and a 
tree falls on a mime, does 
anyone care?—Max

THE RETURN OF 
CLUBBER LANG
I was perusing the vastness 

As long as it doesn’t burst 
into fl ames, you’re set.

I had much diffi culty getting my mouse to work on a glass 
table until I discovered the most appropriate mouse pad.
Incidentally, I also found a use for my PC laptop where it 
couldn’t possibly crash, fail, or otherwise let me down.
—Travis

31%  Finally, a freakin’ iPhone

7%  Steve in a 
(PRODUCT) RED turtleneck 
with a matching soul patch, 
à la Scott Spiezio

27%  Early release 
of Leopard—meaning 
immediately

tell us how you really feel

Survey Says Here are the results of our October 2006 survey. Check out 
www.macaddict.com each month for a new online poll.

What do you 
expect Apple 
to announce at 
January’s Mac 
Expo?

4%  Leopard will 
run on generic PCs

22%  iPod with video and 
a full-frontal, big-screen 
touchscreen

9%  iMac (PRODUCT) 
RED Special Edition
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CONTESTANT INFORMATION  
Full Name:

Address:

City:                                                               State:

Zip:

Email or telephone:    

Congratulations 
to Kenneth Simon, 

whose caption won him a 250GB LaCie 
Brick hard drive ($129.99, www.lacie
.com). Special thanks to the dozens of 
you whose captions centered on either 
bird poop or Pepto-Bismol—and a 
quizzical head-scratch for the one guy 
whose contribution featured both.

Winner!

January 2007    87

Win a Microsoft 
Productivity Pack!
This month we’ve got your highly 
productive self in mind, offering you the chance to win a copy 
of Microsoft Offi ce 2004 Professional Edition ($499, www
.microsoft.com/mac) and a Microsoft Wireless Laser Desktop 
for Mac keyboard-mouse set ($99). All you need to do to win this 
powerfully potent pair of productivity promoters is to write the 
best caption for the image below. Only one entry per contestant.

87

Due to Graphic 
content in this issue of 
MacAddict, parental 
discretion is advised.

to grip it with my thumb. 
I think you should inform 
you readers that this mouse 
may very well be useful for 
people with problems like 
mine.—Ted Leash
We got a lot of feedback 
about that review, Ted, but 
your tip gets our biggest 
thumbs up. Thanks!—Max

VILEFAULT
Sure hope those external 
terabyte drives hit the 
market soon.—Nathan Hart
Or a zettabyte*—then 
you could back up Niko’s 
illustrious library of skanky 
B movies.—Max

iPUMPKIN
We had a pumpkin-carving 
contest in the library where 
I work, and we created the 
iPumpkin. It’s powered by 
a 30GB video iPod, plays 
video on the LCD screen, 
and audio through the 
earbuds (gourds). We’re 

presently taking orders for 
them, but I don’t think anyone 
will buy ’em because they 
decompose rather quickly.
—Joe Barricella
You can’t take it jogging, but 
you can make it into a tasty 
pie.—Max

Saving the day for arthritis 
sufferers—but few others.

You mean you don’t have 
4,092GB to spare?

Earbuds on loan from the jolly green guy.

*A zettabyte is 1 sextillion (1,000,000,000,000,000,000,000) bytes—or 1/1,000 of a yottabyte.

Send email entries to: contest@macaddict.com with the subject: Microsoft Contest (Don’t 
forget to include your address information!) Send snail-mail entries to: Microsoft Contest, 
MacAddict magazine, 4000 Shoreline Court, Suite 400, South San Francisco, CA 94080. 
Deadline for entry: January 31, 2007. Contest results will appear in our May/07 issue.

Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent 
originality, and 33 percent creativity. All entries must be received no later than January 31, 2006, with the winner 
announced around May 2007. By entering this contest, you agree that Future US, Inc. may use your name, likeness, 
and Web site for promotional purposes without further payment. All prizes will be awarded, and no minimum number 
of entries is required. If two or more people enter identical winning captions, the entry received fi rst will be awarded 
the contest prize. Prizes won by minors will be awarded to their parents or legal guardians. Future US, Inc. is not 
responsible for damages or expenses the winners might incur as a result of this contest or the receipt of a prize, 
and winners are responsible for income taxes based on the value of the prize received. A list of winners may also be 
obtained by sending a stamped, self-addressed envelope to Future US, Inc. c/o MacAddict Contest, 4000 Shoreline 
Court, Suite 400, South San Francisco, CA 94080. This contest is limited to residents of the United States. No 
purchase necessary; void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

Entry Form

WIN!

WRITE TO US!
Mac Addict, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080 
or letters@macaddict .com

FOR CD PROBLEMS: 
go to www.futureus.com

FOR SUBSCRIPTION QUERIES: 
call (toll-free) 888-771-6222

Volume 12, Issue 1
MacAddict (ISSN 1088-548X) is published 12 times a year by Future US, Inc., 4000 Shoreline Court, Suite 400, South San 
Francisco, CA 94080. Periodicals Postage Paid at South San Francisco, CA, and at additional mailing offices. Newsstand 
distribution is handled by Curtis Circulation Co. Basic subscription rates: one year (12 issues + 12 CD-ROMs) U.S. $39.90, 
Canada $43.95, U.S. prepaid funds only. Canadian price includes postage and GST 128220688. IPM 0962392. Outside the 
U.S. and Canada, price is $53.95, U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddict, P.O. Box 
5126, Harlan, IA 51593-0626. Future US, Inc. also publishes Maximum PC, PC Gamer, Official Xbox Magazine, PSM, Guitar 
World, Guitar One, Guitar World Acoustic, Bass Guitar, Guitar Legends, Future Music, Future Snowboarding, Snowboard Journal,
Snowboard Trade News, Revolver, and Scrapbook Answers. Entire contents copyright 2006, Future US, Inc. All rights reserved. 
Reproduction in whole or in part is prohibited. Future US, Inc. is not affiliated with the companies or products covered in 
MacAddict. Ride-Along enclosure in the following edition(s): B1, C1, C2, C3. PRODUCED IN THE UNITED STATES OF 
AMERICA. Publications Mail Agreement #40043631. Returns: 4960-2 Walker Road, Windsor ON N9A 6J3

Write a caption 
for this picture.
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JWT TECHNOLOGY
ONE RAVINIA DRIVE, 9TH FLOOR
ATLANTA, GEORGIA, 30346

CONTACT:
Theresa Babington 770-668-5700 x229
Email: theresa.babington@jwttech.com

Everything to concept,collaborate and create.
(Well, except the great ideas.)

• Print speed: up to 17 ppm black, 16 ppm color
• Print resolution: 4800 x 1200 dpi optimized with
 HP PhotoREt III 
• 4" x 6" photo in approximately 45 seconds

HP Deskjet 460c Mobile Color Printer

• Intel® Core™ Duo Processor (2GHz)
• Memory: 512MB
• 60GB hard drive
• SuperDrive™ (DVD±RW/CD-RW)
• Built-in AirPort® Extreme and Bluetooth®

• Built-in iSight™ camera
• 13.3" widescreen display

CDW 982285

$1295
Apple® MacBook™

Apple® Cinema HD Display

• 20" digital LCD 
• Contrast ratio: 400:1
• Response time: 16ms

$699 CDW 659613

$249.99 CDW 848223

Offer subject to CDW’s standard terms and conditions of sale, available at CDW.com. ©2007 CDW Corporation   

You’d like to spend as much time as possible focusing on your creative work. CDW has the 
solutions that let you do just that. Our account managers can help you find the products 
you need to keep the creative process going faster and more efficiently. So call today for 
detailed answers to all your technology questions, and get back to focusing on what you 
really enjoy: creativity.

The Mac Solutions You Need When You Need Them. 
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The ideas in your portfolio should stay true to the ideas in your head. That’s why the 
new HP Designjet series of printers have a built-in spectrophotometer that analyzes 
color and calibrates it to match the media used. So quality stays consistent from print 
to print, media to media. And creating ICC profiles is quick and easy. What’s more, 
the Designjet Z2100 boasts 8 Vivera pigmented inks that can match almost every 
color in the spectrum. These are not just new printers, they’re a revolution in printing. 
Be part of it.

WITH HP YOU CAN PRINT YOUR VISION. 
EVERY TIME.

*Mac and PC fully compatible. © 2006 Hewlett-Packard Development Company, L.P. All rights reserved. The information contained herein is subject to change without notice. Some of the images are simulated.

HP DESIGNJET Z3100* 

24” – 44” pedestal printer 
with 12 Vivera pigmented inks

HP DESIGNJET Z2100* 

24” – 44” pedestal printer 
with 8 Vivera pigmented inks

HP PHOTOSMART PRO B9180*

13” x 19” 8 Vivera pigmented 
inks desktop printer

To request a print sample, or for 
additional information, please visit 
www.hp.com/go/graphicdesign5. 
To speak to an HP Representative 
please call 1-866-625-1176.
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